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Software Starter Guide

(For the Canon Digital Camera Solution Disk Version 12)

You must install the software bundled on the Canon
Digital Camera Solution Disk before connecting the
camera to the computer.

Install the software. Connect the camera
to the computer.

Windows
Macintosh

¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures. Exif Print

¢ Please read the software license agreement in this guide before ™
using the software. By using the software, you agree to be
bound by the terms of the agreement. DPOF
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct use of
the products and to prevent injuries or damage to yourself, other persons and property. Please
read and ensure that you understand them before proceeding to other sections of the guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

e Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer from hearing loss from listening with headphones to
the loud sounds of a CD-ROM played on a music CD player.Disclaimer

Disclaimer

¢ While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to
mistaken operation or malfunction of the camera, the software, the CompactFlash™
(CF cards), personal computers, peripheral devices, or use of non-Canon CF ¢

Trademark Acknowledgments

e Canon and PowerShot are trademarks of Canon Inc.

o ArcSoft, the ArcSoft logo, ArcSoft Photolmpression and ArcSoft Videolmpression are trademarks

or registered trademarks of ArcSoft, Inc.

Adobe is a trademark of Adobe Systems Incorporated.

CompactFlash is a trademark of SanDisk Corporation.

iBook and iMac are trademarks of Apple Computer, Inc.

Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer

Inc., registered in the United States and other countries.

e Microsoft, Windows and Windows logo are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

¢ Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape
Communications Corporation in the United States and other countries. Netscape Communicator
is a trademark of Netscape Communications Corporation.

e Other names and products not mentioned above may be registered trademarks or trademarks of
their respective companies.

Copyright © 2003 Canon Inc. All rights reserved.

Canon Customer Support

For Canon Customer Support contacts, please see the Canon Limited Warranty supplied with
your camera.

Adobe Customer Support

Adobe Systems Inc. technical support information is available in the PDF file format on the
supplied CD-ROM.

PDF File Location and Opening Instructions

Windows:  Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [My
Computer] icon on the Windows desktop, followed by the [Photosle] CD-ROM
icon. The window will show folders with language names. Double-click the
appropriate language folder and the [Support.pdf] file within it.

Macintosh: Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [Adobe
Photoshop LE] icon on the desktop. Double-click the appropriate language folder
from among those displayed, followed by the [Support.pdf] file.

e To read PDF files, Adobe Acrobat Reader must already be installed on your computer. An

installer for this program is on the Adobe Photoshop LE CD-ROM within each language
folder in a folder labeled [Acroread].

ArcSoft Customer Support
North America

46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.



READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN
THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS
AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE
DATA) AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE") AND
PROMPTLY RETURN THE SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1. LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a
single computer. You may physically transfer the SOFTWARE from one computer to another
provided that the SOFTWARE is used on only one computer at a time. You shall not install or use
the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

With respect to the sound and image data (“Data”) contained in the Software, which are to be
downloaded to the applicable Canon digital camera product, Canon grants you a personal, non-
exclusive license to use the Data on a single Canon digital camera product only.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS/ AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and
retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation of
this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be
responsible for providing maintenance or support for use of the SOFTWARE. No updates, fixes or
support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not %uarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON
AN “AS IS" BASIS AND WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM
storing the SOFTWARE is warranted only against defective material under normal use for a
period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by your
sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same
without charge when returned by you at your expense to your point of purchase and proven to
be defective upon inspection. The Replacement CD-ROM will be warranted for the remainder of
the original ninety (90) day warranty period of the defective CD-ROM. The limited warranty does
not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of the
SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR
CONDITIONS, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE
SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.




NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OF IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH
RESULTING FROM NEGLIGENCE ON THE PART OF THE SELLER, SO THE ABOVE
DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO YOU.

. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:

The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995),
consisting of “commercial computer software” and “commercial computer software
documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48
C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.72024 (June 1995), all U.S. Government
End Users shall acquire the SOFTWARE with only those rights set forth herein. Manufacturer is
Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan.

. EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and

regulations of the country involved, and not to export or re-export, directly or indirectly, the
SOFTWARE in violation of any such laws and restrictions and regulations, or without all necessary
approvals.

. SEVERABILITY:

In the event that any provision of this Agreement is declared or found to be illegal by any court
or tribunal of competent jurisdiction, such provision shall be null and void with respect to the
jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall
remain in full force and effect.

. CONTROLLING LAW: The terms of this Agreement as it relates tolrjurchases of the Software in

the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

10.0WNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the

—_
—_

SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the
SOFTWARE is subject to the laws of the United States, and Canada, and other applicable
copyright and trademark laws, and nothing in this Agreement constitutes a waiver of the rights
of Canon, its affiliated corporations and third party licensors under such laws. You only own the
CD-ROM media in which the Software is stored. Except as expressly provided herein, no license
or right, express or implied, is hereby conveyed or ﬂranted by Canon to you for any intellectual
property of Canon. Nothing contained in Paragraph 1 shall be construed to give Canon any
ovx]/tnership rights in any images, graphics or textual material that you save in connection with the
Software.

You may not modify, remove or delete any or all copyright notices (i) which are contained in the
Software, including any copy thereof, and (i) which are on the original CD-ROM and on the
medium of a back-up copy made pursuant to Section 2 above.

.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU

HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE
AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING
THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR
AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN
THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS
AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF
CANON.



Table of contents
Read This First 1
It's so Simple! Make Prints Right at Home Like a Pro .......cccccuuueee.. 2
Unbounded Possibilities with Entertaining Software ..................... 4
About the CD-ROMs in Your Package ......cccoccveeeeiiiiiieneiiiieieeeee 6
System ReqQUIremMENTS .....occueiiiiiiiiiiee e 7
Using the Software on the Windows Platform 9
- Preparations -
Installing the Software and USB Driver .......cccccevcveecieeenieeeiieeenns 10
Using the Software on the Windows Platform 17
- The Basics -
Starting ZooMBIrowWSser EX ....ccooicieieiiiiiieeeiineieciieesiecaeseeseeeeee e e 18
Downloading Images to the Computer .........cccccveiiiieeeeiiiiieeee e, 22
Printing IMages ...t re e e e e 25
Using the Software on the Windows Platform 29
- Advanced Techniques -
The ZoomBrowser EX WIiNdOWS ..........ciceceiiiieeniiieessiieessiie e snsiennns 30
RePIaying IMOVIES ........iieieiiie et e e 32
Converting RAW Images - File Viewer Utility ........cccciviiiicniiennnn 33
Merging Panoramic Images - PhotoStitch ...........cccoiiiniinn, 35
Operating the Shutter Remotely - RemoteCapture ..........cccccueeneee. 37
Enjoy Customizing Your Camera with the My Camera Settings ...44
Using the Software on the Macintosh Platform 51
- Preparations -
Installing the Software ... 52
Using the Software on the Macintosh Platform 55
- The Basics -
Starting IMageBroWSer ........ooi i 56
Downloading Images to the Computer ........ccccceeviiieie e, 63
Printing IMages ... 66




Using the Software on the Macintosh Platform 69
- Advanced Techniques -

RePIaYiNG IMOVIES .ot 70
Converting RAW Images - File Viewer Utility ......ccccooeeniiininiennnnns 71
Merging Panoramic Images - PhotoStitch ........ccccooiiiiiiniienne 73
Operating the Shutter Remotely - RemoteCapture ........ccccoecueeees 75
Enjoy Customizing Your Camera with the My Camera Settings ..82
Downloading Images with the USB Mounter .........cccccccvvecivenennnn. 87
Information about Your Camera 91
Information Common to All Models ..o 92
POWEISNOT S50 ... 94
PowerShot S400 DIGITAL ELPH/DIGITAL IXUS 400 .......ccceeeuvveeennnn. 95
POWEISNOT A70 ... 9%
POWEISNOT ABOD .....oiiiiiiieee e e 97
POWEIrShOt A300 ...oooiiiiiiie ettt 98
POWEIShOt G3 ...t r b e 99
POWEIShOt SA5 ...ttt e 100
PowerShot 5230 DIGITAL ELPH/DIGITAL IXUS V3 .....cceoeveurennne 101
Appendices 103
About the CD-ROMs in Your Package ..........cccoeeerieieeeneessnieeeenne 104
Uninstalling the Software ...........ciceeiie ettt 110
Memory Card Folder Structure ..........ccccceveceeenciieescsie e 115
Troubleshooting .......ocoioiie et 116



=
o
3
w
~~
=
2
=
5
=
(=]
w
=

Read This First

This chapter explains what you can accomplish using the camera with the
software contained on the Canon Digital Camera Solution Disk.

It also lists the computer system configurations required to use the software.

About this Guide

*The explanations in this guide are based on Windows XP and Mac OS X
v10.2. If you are using another version of these operating systems, the
actual screen contents and procedures may vary slightly from those shown.

e This guide uses the following notations on the right to represent the items
on the left.

Mac OS X (v10.1/10.2) -> Mac OS X
Mac 0S9.0-9.2 > MacO0S9
CF Card, PC Card -> Memory Card




I It's so Simple!Make Prints Right at Home Like a Pro

It's so Simple! Make Prints Right at Home
Like a Pro

r— Shoot the images _\

See your Camera User Guide for shooting instructions.

Install the software on the

(_ computer _\
-
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Just install the software once at the beginning.




( Connect the camera to the computer —\
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I Unbounded Possibilities with Entertaining Software

Unbounded Possibilities with Entertaining
Software

Print a Variety of Layouts

Print with the diverse layouts available in PhotoRecord (Windows) and
ImageBrowser (Macintosh).

The examples shown are from
PhotoRecord (Windows).

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch.




Send an Image as an E-mail Attachment

Attach an image to an e-mail message by starting your mail software from
within ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer

Release the camera’s shutter from the computer with RemoteCapture. The
recorded image is saved directly to your computer.

Release the shutter from the computer.

Convert RAW Images

Use the File Viewer Utility to convert RAW-format images downloaded to the
computer into standard photo formats, such as the TIFF and JPEG formats. It can
make fine adjustments to the image quality and coloring during conversion.
(RAW format images can only be recorded by select camera models.)
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I About the CD-ROMs in Your Package

About the CD-ROMs in Your Package

About the Supplied Software

In addition to the Canon Digital Camera Solution Disk, your camera may be
accompanied by other CD-ROMs containing image editing software. Your
choice of camera model will determine which disks are included.

See Information about Your Camera (p. 91) to read which disks are included
with your model.

For a description of the features and installation procedures for the software
on the CD-ROMs, see About the CD-ROMs in Your Package (p. 104).




System Requirements

Please install the software on a computer meeting the following minimum
requirements.

(013 Windows 98 (First or Second Edition)
Windows Millenium Edition (Windows Me)
Windows 2000

Windows XP (Home Edition, Professional)
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Computer Model The above OS should be pre-installed on computers with built-
in USB ports.

CPU Windows 98/ Windows Me/ Windows 2000: Pentium 150MHz
or better

Windows XP: Pentium 300 MHz or better

RAM Windows 98/ Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more
Interface UsB
Free Hard Disk e Canon Utilities
Space - ZoomBrowser EX: 120 MB or more
(Including the PhotoRecord printing program)
- File Viewer Utility: 100 MB or more
- PhotoStitch: 40 MB or more
- RemoteCapture: 20 MB or more
e Canon Camera TWAIN Driver: 25 MB or more
e Canon Camera WIA Driver: 25 MB or more

800 x 600 pixels/ High Color (16 bit) or better is required
1,024 x 768 pixels or better is recommended

® ¢ A CD-ROM drive is required to install the software.
¢ A sound card is required to play movie audio tracks.

¢ All procedures performed with a connection to a USB 2.0
compliant board are not guaranteed.




I System Requirements

oS Mac 0S 9.0 - 9.2, Mac OS X (¥fsion 0.10.2)
Computer Model The above OS should be pre-installed on computers with built-
in USB ports.
CPU PowerPC
RAM Mac OS 9.0 - 9.2:20 MB or more of application memory
Mac OS X (¥fsion 0.1 0.2):28VIB or more
Interface UsB
Free Hard Disk €anon Utilities
Space - ImageBrowser: 50 MB or more
- e Mwer Utility: 00 MB or more
- PhotoStitch: 30 MB or more
- RemoteCapture: % MB or more
¢JSB Mounter: 5 MB or more
Display 80 x 60 pixels/ 32,000 Colors or better is required

1024 x Bixels or better is recommended

@ ¢ A CD-ROM drive is required to install the software.

eImageBrowser, File Mwer Utility, PhotoStitch and
RemoteCapture are compatible with'Mac OS X (v10.1/10.2).
blwever, they are not compatible with disks formatted with the

Unix File System (UFS).
¢ All procedures performed with a connection to-a USB 2.0
compliant board are not guaranteed.




Using the Software on the Windows
Platform

This chapter explains the basic procedures for installing the software and
connecting the camera to a computer. Read this material before you connect
the camera to the computer.
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I Installing the Software and USB Driver

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

® eYou must install the software before you connect the camera to
the computer.
e Users of Windows XP Professional and Windows 2000 must first
log in as an Administrator (computer system administrator) to

install programs.

ltems to Prepare

eYour computer
e Canon Digital Camera Solution Disk supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT
connected to the computer. If it is,
disconnect it and the cable from the
computer.

2 Close any programs that are
running.

3 Place the Canon Digital Camera Solution
Disk in the computer’s CD-ROM drive.

The installer panel will display automatically.

If the installer panel does not appear
automatically, use the procedures in How to
Display the Installer Panel on the next page.
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4 Click [Software Installation].

Canon

# QuickTime 5.0 Installstion

Installer Panel

® Canon Digital Camesa Web S

SOLUTION DIEK o

5 Click [Next].

6 Read the software license agreement and click [Yes] if you consent to
all the conditions.

How to Display the Installer Panel

Use the following procedures to display the installer panel if it does not
appear automatically.
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Windows XP

1. Select [My Computer] from the [Start] menu.

2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe] @ icon.

Windows 2000, Windows Me, Windows 98

1. Double-click the [My Computer] icon on the desktop.

2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [Setup.exe] & icon.

(Some computers may not display the [.exe] file name extension as
shown above.)




12 I Installing the Software and USB Driver

7 select your camera model name and click [Next].
Just click [Next] if your camera model name does not appear in the list.

Canon Digital Camera Solution Disk.

Camera Selection

If your camera type is listed below, select it and click [Next].
11t is o, elick [Next] without making a selection
Place a check mark
beside your camera

model name.

PowerShot 545
17 DIGITAL 320
PowerGhot 5230
DIGITAL IXUS v3

Select All Clear All

Chouse Dustisatun Lot \
Select fokden whare Setup vl ritel s \

Lol Neod. To mstal b . ik, Browos ard selecl

Installation destination

9 select the programs you wish to install and click [Next].
Confirm that there is a check mark beside the names of the programs you
wish to install.

The USB Driver (the software for connecting) is required
when the camera is connected to the computer with a USB
cable. Ensure that you select a USB driver from below (the
appropriate one for your operating system).

e Windows XP: no driver required for some models*

¢ \Windows 2000:Canon Camera TWAIN Driver
¢ Windows Me:Canon Camera WIA Driver
¢ Windows 98:Canon Camera TWAIN Driver

* The Canon Camera WIA Driver is required for Windows XP
with the PowerShot G3, PowerShot S45 and PowerShot
$230 DIGITAL ELPH/DIGITAL IXUS v models.




Canon Digital Camera Solution Disk

Select Features

Choose the features Setup will install.

h Descip
wer Uity A applcation program that
Capture merges 2 seies of overlapping
1 images inlo a single. seamless
§iowser EX/PhotoRecard poarans
f) Camera Wil Diiver

Space Requiedon C 305 MB
Space Available on C 578 MB

<bffl ’Eam:e\

Canon Dighal Camera Salution Disk

Stant Copying Tiles
vy salleggs bidiam copprsy lims

ot R P i ;
charms any el chch Bach. || ot 3t sabiedios vlh e seflngs. chck. Neod b b
copyng fle

Cuminnt Seftirgr

[Dnsiration Folder A

T:\Pingum Flea'\Caron
Progiares tn be rataliot

The installation will start. Follow the onscreen instructions to proceed.

9.

10 Review the installation settings and click [Next].

| Theitemsdisplayed here

differ according to the
software installed.

17 Click [OK] if the following message appears.
This message will display if you selected and installed the USB Driver in Step

L Canan Solution Disk setup program has copied the required files ta your computer.
1 After closing setup, connect the camera to the computet.in PC eonnection mode with the cable.
The rest of the installation wil proceed automaticaly,
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I Installing the Software and USB Driver

12 When the installation is over, select [Yes, | want to restart my
computer now.] and click [Finish].

Loy [Higgital Canmera Solution ik

st ol ehl Wizan! Losglele

The InstaliGhieid Wizerd hat iuccers
Uik, Blisim g . wicm lhom paimes, s raze il praa

computel

T Ho. | will iestan my compules ksl

Remervrs any dikes bom theis ives, and then, ek Firish tn
st el

Users of Windows XP Professional and Windows 2000 must

log in as an Administrator (computer system administrator)
after restarting to carry out the subsequent procedures.

13 Remove the disk from the CD-ROM drive
when your normal desktop screen appears
after restarting.

This concludes the software installation.
Continue by connecting the camera to the
computer so that the USB Driver can be
utilized.

If you installed a USB Driver, so far the required files have
only been copied to your computer. You must now connect

the camera to the computer with the USB cable to complete
the installation and prepare the driver for use.

See alling the Software (p. 110) to delete the software
i ed with these procedures.
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14 Attach the camera to the computer and set it to the correct mode for
connecting.

Procedures for attaching the camera to the computer and
placing it in the correct mode for connecting vary between
camera models. See Information about Your Camera (p. 91)
for details.

The USB Driver will automatically finish installing onto the computer when
you attach the camera and open a connection. Dialogs similar to the
following ones will appear during this process (first connection only).

Windows XP
The following dialog will appear after a few moments and the USB Driver
will automatically install.

L2

4,‘ Found New Hardware |*| Recyvdle Bin

Canon Digital Camera
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Windows 2000/Windows Me/Windows 98
The "Add New Hardware Wizard" will appear after a few moments and
the USB Driver will automatically install.

IWn Step 9 will automatically install.

Restart the computer according to the instructions if you are prompted to
do so by a message.

The Events dialog will appear after installation, allowing you to select an
application to start. The explanation for these procedures is contained in
Using the Software on the Windows Platform-The Basics (p. 17).




]6 I Installing the Software and USB Driver

This concludes the software and USB Driver installation and the procedures for
connecting the camera to the computer.
You may now download camera images to the computer (p. 22).
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Using the Software on the Windows
Platform

This chapter explains the procedures for using ZoomBrowser EX to download
the camera's images to the computer and print them.
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Read this chapter after completing the preparations in the Using the Software
on the Windows Platform - Preparations - section.




]8 I Starting ZoomBrowser EX

Starting ZoomBrowser EX

Begin by starting up ZoomBrowser EX. The startup procedures vary according to
whether you are connecting the camera to the computer or using a memory
card reader.

Camera to Computer Connection

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication
with the computer.

Procedures for attaching the camera to the computer and
placing it in the correct mode for connecting vary between

for details.

A dialog (Events dialog) similar to that below will appear after a moment.
Select the application program you wish to start from the list in this dialog.

Your camera model name

or "Canon Camera" will
appear here.

Device Connected

Select the program to launch for this action:

Microsoft Scanner and Camera ba/izard Select an a PP lication
4 Download pictures from & eamera or scanner program here.

|1 &lways usz this program For this action

If the above dialog (Events dialog) does not appear, open it
with the procedures described in How to Display the Events

Dialog on the next page.
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2 sclect [Canon ZoomBrowser EX] and click [OK].

ZoomBrowser EX will start and open its Camera Window. The camera
images will display as thumbnails (tiny versions) in the Camera Window.

Camera Window

BEEEER -

T Y T

(S

Frinted collecting mages for daglay, Tokak: & mages.

A dialog allowing you to select the camera model will

display if a camera and a memory card readerare connected
at the same time. Confirm that your mo or "Canon
Camera" is displayed and click [OK].
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How to Display the Events Dialog
Use the following procedures to start ZoomBrowser EX and display the
Camera Window.

1 Double-click the [ZoomBrowser EX] icon on the -

desktop. @

ZoomBrowser
Ex

2 Click [Camera & Memory 5 P e ey e e
Card] when ZoomBrowser EX -
starts.

3 Click [Browse & Download
Images] in the next menu.

This will display the Camera
Window.
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A message asking whether you wish to continue the
connection may appear after some camera models are
connected to the computer. See Connection Confirmation
Message Displays (p. 117) in the Troubleshooting section
regarding this message.

Next, download images to the computer (p. 22).

Memory Card Connection

1 Insert the memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling
instructions.

Place the memory card in an
adapter if required.

Insert the loaded adapter
into the slot.

2 Sstart ZoomBrowser EX.
Double-click the [ZoomBrowser EX] icon on the desktop.

ZoomErowser
Ex
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3 Click [Camera & Memory Card].

T . = EIEk

File Edt View Tools Intermet Help

Ll FOLDERS

B B @ %

7] Desktop Properies Ratate Delete:
g

HEs My Documents
] My Albums
1] My eBacks
|1 My blusic
I {1 My PageManager
My s
] My Videos
[ et
chedulel utput
BHEL My Computer

Sirs Image

My Pitres

and settingsy pictures

File Edit View Took Internst Help
Camera & Memory Card . FOLDERS

& 7o Desktop
7

==

—

5
o
o
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w
| ]
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This will display the Camera Window. The memory card images will display
as thumbnails (tiny versions) in the Camera Window.

See Memory
ures and file names.

Next, download images to the computer (p. 22).
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Downloading Images to the Computer

1 Click on images in the Camera Window that you wish to download.
The background color of the selected images will change to orange.

&7 CameraWindow: El

Eamela & Memory Card
1 2 3 4 Lt E
w Thumbnail

Download image

Print

View as slideshow

Connect to internet

Finished collecting images for display. Total: 6 images

|
“RAW" displays on RAW The movie icon displays on

image. movie thumbnails.
If you are downloadi selected with the
camera’s [Transf i ct] and select

£ CameraWindow;

Camera & Memory Card

s
- e

View as slideshow |

Connect to internet

Finished collecting images for display. Total: 6 mages

A Download Settings dialog allowing you to select the image destination
folder will display.



3 Confirm the destination folder and click [OK].

Specify the destination folder
for the image(s).

(You can change the destination
Sty v il folder by clicking [Browse] and
selecting a new destination.)

Download Settings

Save Lo fold

g
IC:\Documents and SettingsJohnthy Documen Browsze. .. ’

(" Do not cre

Select [Create new folder] to
create a new folder within the
one specified above, and select
a naming option.

& Create new folder
Falder name: {* Shooting date
" Downloaded date

" Set as new

[<{E

[™ Designate prefix of image to be saved

File prefis: I

< !Cancel |

At this point the Camera Window will close and the Main Window will
open. The downloaded images will appear in the Main Window.

Fle Ede View Took Intemet Heb

Viom & Moy

'-_

Posiiost o — Main Window

Continue by printing out an image (p. 25).
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I Downloading Images to the Computer

Other Methods of Downloading Images to the Computer

* Windows XP

Your camera uses a standard image transfer protocol called the Picture
Transfer Protocol (PTP). With the PTP and Windows XP, all you need do is
connect the camera to the computer with a USB cable to download images.
It is easy using the Scanners and Cameras Wizard and other procedures. (You
do not even need to install ZoomBrowser EX or the USB Driver.) However,
there are some inconveniences and limitations to this downloading method.
See the For Windows® XP and Mac OS X Users leaflet for details.

See the Picture Transfer Protocol (PTP) Mode leaflet if you are using a
PowerShot G3, PowerShot S45, or PowerShot S230 DIGITAL ELPH/DIGITAL
IXUS v3. In addition, set the camera's transfer setting to [PTP] if you use this
method to download with these models.

* Windows Me (with the USB Driver installed)

It is easy to download images using the Scanners and Cameras Wizard or
Windows Explorer. All you need do is connect the camera to the computer
with a USB cable. (ZoomBrowser EX does not need to be installed.) However,
you cannot download RAW format images or movies with these methods.

See the Windows Help system for information about the Scanners and
Cameras Wizard and Windows Explorer.
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Printing Images

1 Cclick [Print] in the Main Window.

R and settings w pictures B

File Edit View Tools Internst Help

Ll FOLDERS

B[ Deskiop
EHES My Documents
7 My Albume

T My eBosks
| 51 My Mhusie
|51 My PageManager
My Pictures
B (] Animal
B navelogue
T o
erdscape
L7 Mu Videos

Camera & Memory Card

[ and

File Edit Wiew Tools

Intemet  Help

Print @ FOLDERS

=
o
o
=
w
| ]
-
-
@
w

(1 My =Books
(1 My Music

3 Click on the image(s) you wish to print and click the [Next] button at
the window's bottom right.

( |

L || ... P

The background color of the selected images
will change to orange.

Iﬁl Mwot be printed.
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4 Place a check mark beside the data you wish to include with the print
(multiple selections are possible) and click [Finish].

v and settings/i 1y wy picture:

| File Edit wiew Tools Internet Help

. Layout Print

Select Images

STEP 2 © Select captions for printing

You can choose to attach to each image any or all of th

For example, you can print

the shooting date and time
with the image if you select
[Date and Time] here.

The PhotoRecord printing utility will start and display the PhotoRecord Print
Modes window.

O comment
O File Name
O Date and Time

DOpen Layout Print. .

A comment can be attached to an ima
ZoomBrowser EX, clicking [Properti

comment.
5 Confirm that [Artwork/Layout album] is selected and click [Next].

y selecting it in
yping the

PhotoRecord Print Modes |EEJ
PhotoRecord can arange your phates for printing in a number of
ways. Choose one of the print modes supparted for your printer.
Example
Printer: I Canan $xkx _v_] e
EaT
BJ Cartridge:  Phata ‘ w
g N T LI
+ Aotk /Layout album &l 4 = naFa
_-==an
IReT T 2e printing e NE
" Borderless printing [Tiled phaota) Iry dsrtwork /L apout alburm print
mode, you can use artwork and
" Canon perforated paper printing contiol the position and ratation of
your photos.
[+ Show this wizard on starbup < Bar! | Mest > | Cancel | Help
A 4

Iﬁl“en you select "Artwork/Layout album", you can resize or
reposition images freely for printing.
*The other print modes allow you to do such things as tile
the images for printing or arrange them for printing on
Canon perforated paper.
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In the next window, set the paper size and the other settings and
click [Next].

PhotoRecord Print Modes

You now need to enter the paper settings to use .
for wour album, i Preview

I Use Canon Borderless Printing

dedia Type: IP\am Paper 'I
Faper Size: ILetleI v]

Orientation: () Ic This preview shows an

example album with your
current settings.

Set Page Margins.... |
y

v Show this wizard on startup < Back ‘ | MNest > I ’ Cancel | Help |

e

In the last window, select [Automatic layout] and click [Finish].
This will display the PhotoRecord window.
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PhotoRecord Print Modes

The photag in vour album can be sized and
positioned in a number of ways, How waould you
like this to be done?

" Index layout

€ Manual layout

Click the PhotoRecord [Print] button.
This will display the Print dialog.

AUTO  (NDEX

PRINT

Open the photo viewer 7
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9 Click [Print] to start printing.

Iﬁl *The Index Print Settings dialog will open if you select [Index
Print] in Step 2 and complete steps 3 and 4. You can select
the settings, such as the thumbnail size and paper size, and
click [Print] to start an index print.
eImages shot with Exif 2.2-compliant cameras (Exif Prints)
incorporate information about the shooting settings, such
as the camera modes and settings. Better prints can be
made by using this information to correct the image.
To correct image quality, right-click an image and select
[Clip/Correct Photo] from the pop-up menu. Place a check
mark beside [Exif Print] or [Photo Optimizer Pro] in the next
window and click [Close] to have it corrected. You should
obtain better results when the image is printed.

This concludes the image printing process.

This chapter explained the ZoomBrowser EX basics. Once you have
mastered them, read the following chapter to try the advanced techniques.
Using the Software on the Windows Platform - Advanced Techniques (p.
29)

is also ilable.

ram's features
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Using the Software on the Windows
Platform

- Advanced Techniques -

This chapter explains various ZoomBrowser EX features, such as how to play
movies, create panoramic images and operate the camera shutter from the
computer.

Proceed to this chapter once you have mastered the basic ZoomBrowser EX
procedures in the Using the Software on the Windows Platform - The Basics
chapter.

=
=
s
=
wv
n
=
s
s
3
"
e
2
e
[
s
=
S
s
(]
n




30 I The ZoomBrowser EX Windows

The ZoomBrowser EX Windows

ZoomBrowser EX has two windows: the Camera Window and the Main
Window. This topic explains the features of these two windows.

This window can be used to view images in the camera (or memory card) and
download them to the computer.

A window allowing you to specify the download The images from the camera (or
destination opens when you select images and memory card) display here.
click the [Download image] button

Task Buttons —
These buttons
select the task
to carry out.

Function Buttons
These buttons apply functions to images
selected in the Camera Window.

JPEG images are rotated with the manual rotation
settings

*\When JPEG images are rotated in the Camera Window

To download both the pre-rotation and post-rotation images,

click the [Tools] menu in ZoomBrowser EX's Main Window and

select [Preferences], followed by the [Rotate] tab. Place a check

mark beside [Rotate a copy of the JPEG image].
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This window can be used to organize the images downloaded to the computer.
It can also be used for other purposes, such as printing images and attaching
them to e-mail messages.

Folders Area Function Buttons
Select image folders here. As in Windows ~ These buttons apply functions to
Explorer, you can view the contents of images selected in the Browser
the folders. Area.

fer] R 080 8 04 o ] ¥
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Task Buttons Browser Area
These buttons select Displays the images contained in the
the task to carry out. folder selected in the Folders area.

Double-clicking an image shows it at a
larger size.
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I ° °
Replaying Movies
When you double-click an image with a movie icon in the ZoomBrowser EX's

Browser Area, QuickTime Player will start and replay the movie.

1 Double-click an image with a movie icon. B3 314 MVI AV _ox
QuickTime Player will start. —— e

2 Click the play button u in QuickTime
Player.

The movie will replay.

02:00:00 1

o

iﬁ?! 000 OO Uz

Do not double-click a movie file (.AVI extension) in the Windows
Explorer to play it. That will start Windows Media Player, which
may not support this file type. To replay movies, use

ZoomBrowser EX as instructed above, or.if you'are using
Windows Explorer, start QuickTime Player first and open the file
from within the program.

Installation Procedures for QuickTime

1. Set the Canon Digital Camera Solution Disk in the CD-ROM drive.
The installer panel will automatically appear. (Display it with the
procedures in How to Display the Installer Panel (p. 11) if it does not

appear.)
2 Click [QuickTime 5.0 Installation].

Canon

& Canoe Dugilal Cameta Web Site

Follow the onscreen instructions to proceed with the installation.




Converting RAW Images - File Viewer
Utility

Images can be recorded in the RAW format (RAW images) with certain camera
models. RAW images are extremely high-quality images that are not degraded

by compression algorithms when recorded. However, they are not supported by
most image editing programs in their native format, so they must be converted
before use.

Use the File Viewer Utility to convert RAW images.

Iﬁl eSee Information about Your Camera (p. 91) to see if your camera
supports the RAW format.
eSee your Camera User Guide for the settings required to shoot

RAW images. A

Converting RAW Images

1 Click [View & Modify] in ZoomBrowser EX's Main Window and
[Process RAW Images] in the next menu.

2 select a RAW image in the Browser Area and click [Finish].

The File Viewer Utility will start and display the selected RAW image in the
list.

3 Perform image quality adjustments as required.
See Image Adjustment Features (p. 34) for instructions.

4 Click the [File] menu and select [Save File] and [Convert and save in
file].
This will display the Save File dialog.

5 select a file destination and format for the image you wish to
convert.

You can save the image in the JPEG or TIFF format.

6 Click [OK].
The utility will start to convert the image and save it to the computer.
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34 I Converting RAW Images - File Viewer Utility

File Viewer Utility Features

Preferences Button Save Button Buttons for selecting images.
Use this button to select  Converts and saves the image.
image transfer
applications. You can also
use it to adjust RAW image
processing settings.

Image Selection Button
Selects the method for selecting
images.

Help Button
Displays help
topics.

- Canan Bigh i Can era File Viewes Utllity - Fbder - eAdocumunts and settfngsbohaany documestsiory § kturos,.. [= |1 3]5]

Version
Information
Button
Displays the
program

B version
information.

b L Displays a
histogram
(distribution
of brightness

— > data) for the
! I o image.
Display Mode List Box Comment Box
Selects the thumbnail A description of up to 60 — Displays the
or preview display characters can be input here. image

de. information
mode Display Size List Box Wore.

Selects the size at which images display.

Image Adjustment Features

The following items will display when you select a RAW image and a camera
model name in the Model-Specific Processing Mode list box.

This section displays when a camera model
name is selected in the Model-Specific
Processing Mode list box.

Model-Specific Processing Mode List Box
Selects the model of camera in use.

- Canon Digital Camera File Viewer Utility - Folder - c:ido :uments and settingshJohnimy documentsimy pictures... ||
FiledF) Edt(E) ‘iew(V) Help(H)

HIRCEIEFE T EEI P M
E] \mm;ﬂ dgm’\sy ] [rarge ] [mecononne T - )
;}i!s_hm ST Pt Rt ek |

]| 8 [sret scting= E|K W U] | ree B

Sets the Photo  Adjusts image Adjusts
Effect mode. contrast. image color
saturation.

Click this button and then
a white portion of an
image to automatically
adjust the white balance
to that color. Adjusts the sharpness.

Adjusts white balance settings.



Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images, such as
those shot in the camera's Stitch Assist mode.
Use the PhotoStitch program to merge the images.

Starting PhotoStitch

Start PhotoStitch from ZoomBrowser EX.

1 dlick [View & Modify] in the ZoomBrowser EX's Main Window and
[Stitch Photos] in the next menu.

2 Select a series of images in the Browser Area and click [Finish].
A window similar to that below will appear.

Follow the instructions
to merge the images.

3 Merge the images following the instructions in the guidance panel
at the top of the PhotoStitch window.

the QuickTime VR format. (QuickTime is
e Canon Digital Camera Solution Disk.)

35
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36 I Merging Panoramic Images - PhotoStitch

Images Shot in Stitch Assist Mode

It is easy to merge images shot with the camera's Stitch Assist mode since
PhotoStitch automatically arranges them in the correct order and orientation.
Stitch Assist mode images appear in the Camera Window as shown below.

Images shot in Stitch Assist mode display a mark
like this.

Download image .
- - - . - - |
Print = = |

~ e |
Wiew as slideshow

Connect to internet |

e
Finished collecting images for display.

Total: 6 images

shown en images

t shooting in



Operating the Shutter Remotely -
RemoteCapture

You can use a computer to control the shutter of a connected camera to record
still images. This is particularly useful for checking images on the larger
computer display as you record them.

Start the RemoteCapture program to perform this task.

Starting RemoteCapture

Start RemoteCapture from ZoomBrowser EX.

Close the ZoomBrowser EX Camera Window before starting

RemoteCapture.

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal. Prepare the camera for communication
with the computer.

Procedures for attac

for deta

2 Open the lens cover or remove the lens cap on models equipped
with them.

Proceed to Step 3 if your model does not have one.

3 Select [ZoomBrowser EX] in the dialog (Events dialog) that allows
you to select an application program, and click [OK].

This will start ZoomBrowser EX and display its Camera Window.

4 Close the Camera Window.
This will open ZoomBrowser EX's Main Window.

5 Click [Camera & Memory Card], then [Remote Shooting] in the next
menu.

This will start RemoteCapture.

6 Click [Connect] when the "Connect to camera?" prompt appears.
This will display the Shooting - RemoteCapture window.
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38 I Operating the Shutter Remotely - RemoteCapture

RemoteCapture Features

RemoteCapture has two windows: the Shooting-RemoteCapture window and
the Save-RemoteCapture window. Use these windows to record and save
images, respectively.

Shooting-RemoteCapture Window

Recordable Image Counter

Displays the number of images that will
fit onto the computer or memory card in
the camera.

Detail Settings

The Detail Settings
dialog opens when
you click the arrow
symbol on the left.

& Shooting - temutaCopture

CamersC]  Shelitngls)

10086 i = ﬂ— Release Button
W s ] : Releases the

shutter.

- Teom shriog
Shooting modes sl

Viewfinder Display e v el
Click the [Viewfinder |

On] button while a—
connection to the
camera is open to
display the image
appearing in the
camera’s viewfinder.

Setthe basiccamera
settings here.

Slide this to zoom

Viewfinder On/Off — .
the camera in or out.

Button bt sicac bumon or sy ber b9 st
Turns the viewfinder Reflect Changes Button
display on or off. Updates the settings.

moteCa osure and focus settings for the
ject m finder section. If the lighting or
changes, click [Reflect changes] to reset
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The following limitations apply when the Viewfinder image is

displayed with a DIGITAL ELPH/DIGITAL IXUS series camera.

*The Viewfinder will automatically turn off after you shoot or
after 1 minute passes after it is turned on. Click [Viewfinder On]
again to turn it back on. However, you may have to wait a

moment for it to come back on if the camera body temperature
has risen.

*The camera's LCD monitor does not display while the
Viewfinder is on. In addition, the Video OUT settings cannot be
set with RemoteCapture.

Save-RemoteCapture Window

Connect/Disconnect Button

Click here to open a connection to the camera and
display the RemoteCapture Shooting window. It will
change to the Disconnect button while a connection is

Thumbnail View
Displays thumbnails of
all the images shot after
RemoteCapture is
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started. open. Click it to close the connection.
% Save - RemoteCapture \z\ _.E|
File Edit Wiew Help
1 Disconnect
o View Button
i Displays images
selected in the
Thumbnail View
area at a larger
size.
Delete Button
LCanon RXex R RKmRE Deletes images
:E%j‘w‘%%%ﬂé%”%;ws PH selected in the
ti . .
Foadi Thumbnail View
Fhato Effect bMode
off
Tl Shutter Spesd | area (completely
ool Apetaaovabs from the computer).
Commerts
Ready | UM
Image Display Area Comments | Histogram
Displays the image Add a comment about the Check the distribution of
selected in the image here. brightness data here.
Thumbnail View.
Image Information
Check the image settings here.
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Shooting with RemoteCapture

If your computer is set to go into standby mode, there is no
guarantee that RemoteCapture will continue to function after
the computer enters standby mode. Always turn off the standby
function before you start shooting with RemoteCapture.

1 Click the arrow to the left of [Detail Settings].
The full-view Shooting-RemoteCapture window will display.

2 Click [Viewfinder On] and view the image in the Shooting-
RemoteCapture window.

Change the settings if required. To update any changes made in the Detail
settings window, click the [Reflect changes] button.

3 Set the Size/Quality and Rotation settings in the Shooting-
RemoteCapture window.

You can save images of people and other subjects that are shot in portrait
orientation (camera held 90° on end) to the computer in the correct
viewing orientation by setting the [Rotation] category to [90 degrees left] or

[90 degrees right].
Capture c‘ sed if
the Auto Rot nction and

4 Click the [Release] button.

Images shot with RemoteCapture are automatically saved to the folder
selected in ZoomBrowser EX.

T
*You so release the shutter by pressing the camera's
r button or the keyboard's space key.
e zoom controls and other camera buttons and switches,

except for the shutter button, cannot be operated while
RemoteCapture is controlling the camera.

eYou may notice that the interval between the shutter
release and activation is slightly longer when
RemoteCapture is used to shoot than when the camera is
used in the normal fashion.



Interval Timer Shooting

Interval timer shooting is a method of shooting that records a specified number
of frames at set intervals.

1 In the Shooting-RemoteCapture window, click the [Interval Timer
Shooting] tab.

This will display the Interval Timer Shooting window.

2 Sset the number of frames and the interval value and click [Start].
This will record the specified number of frames at the specified interval.

Iﬁl eYou can set the time interval between 5 seconds to 60
minutes.
eYou can capture up to the number of recordable frames
displayed in the Shooting-RemoteCapture
actual limit is 9999 frames when the di
10,000 or higher).

Please note that the camera will not be able to shoot at the
specified interval if it is shorter than the time required to
transmit the data and save it to the computer.

Timer Shooting

Timer shooting is.a method of shooting that records a frame after a specified
number of seconds.

1  In the Shooting-RemoteCapture window, click the [Timer Shooting]
tab.

The Timer Shooting dialog will display.

2 Sset the timer interval and click [Start].
This will record an image after the specified time has elapsed.

Iﬁl You can specify a timer interval from 2 to 30 seconds.
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42 I Operating the Shutter Remotely - RemoteCapture

Changing the File Destination and Method of Saving
1

In the Save-RemoteCapture window, click the [File] menu and select
[Preferences].

This will display the Preferences dialog.

Select the way images are saved and the folder to which they are
saved and click [OK].

Sets whether images are saved only to the [ TE—
computer or to both the computer and the i o eoe

;  Computmcel
memory card in the camera. Memasy e i then ongul

e Fik Finie [Up i 16 ehauacters]

Siat
il

Input a root name for the image files here. If J— g T
you input “Capture”, for example, the first h
image will be named [Capture_00001.jpg]
and successive images will automatically be
assigned a name that is one number higher
than the last.

Foldar fo which ot se Ciomrkonded

Select a folder where images will be saved.

{71 UseiDaia »
Select the drive on the computer where —— ¢ L W

images will be saved. N

i3 Cancel

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor.

WN

In the Shooting-RemoteCapture window, click the [Camera] menu
and select [Camera Display Settings].

The Camera Display Settings dialog will display.

Select [Camera LCD monitor] and click [OK].
In the Shooting window, click the [Viewfinder On] button.
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Printing an Index of the Thumbnail Images

You can print an index of all the thumbnails displayed in the Thumbnail View
area of the Save-RemoteCapture window by clicking the [File] menu and
selecting [Print Index]. This provides a convenient register and means of
checking your images since the file name and shooting date are also printed
with each image.
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44 I Enjoy Customizing Your Camera with the My Camera Settings

Enjoy Customizing Your Camera with the
My Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-
timer sound are called the My Camera Settings. You can add your favorite
images and sounds from your computer to the My Camera Settings in the
camera. This topic explains how to upload the My Camera Settings saved onto
your computer to the camera. Use ZoomBrowser EX to perform this function.

Please check whether or not your camera model supports
this function. See Information about Your Camera (p. 91) for
details.

Displaying the My Camera Window

To save the My Camera Settings to the camera, you use the My Camera
window. The following explains the procedures for displaying the My Camera
window.

1 The Camera Window will open after you have connected the camera
to the computer and started ZoomBrowser EX.

For starting instructions for ZoomBrowser EX, see Starting ZoomBrowser EX
(p. 18).

2 Click [Set] in the Camera Window and select [My Camera] in the pop-
up menu.

Alternatively, you can click [Camera & Memory Card] in the Main Window
of ZoomBrowser EX, followed by [My Camera Settings] to display the My
Camera window.

o1 Camerafindow

Camera % Memory Card

Download image

Print
2003/03/04 2003/03/04 2003/03/04
11:4450 11503 11:50:23

View as slideshow

Connect to internat

Camera Settings
idsDPOF

Total: 6 images J

Finished collecting images for display.
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ZoomBrowser EX already contains several pre-recorded My
Camera Settings items. You can check these items with the
My Camera window.

The My Camera Window Features

Tabs

Click here to switch between adjusting the
settings individually or in themed sets. If the
[Set individually] tab is selected, the Data
Type can also be selected.

I—. ety o 0 theern St indradanly

oot by Camars s Type and vt individhanty

Play Button
Click here to play sounds recorded
onto the camera.

iy Cotspner

Do Tyoe:
Displays the list of My
Camera Settings files
saved onto the
computer.

. Displays the My
Camera Settings

B
i@l ——J" -|_|n the camera.

Add File Button
Click here to add a file
as one of the My

Camera Settings to

FABUEIVERT. S50 il
FRORIT 35T WAV
Iharzunidt ssarwmy

Py

—_— e | '-mll

Chalet

_ ST e Delete Button
— Deletes a setting
(i@ from the Camera

list.
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the My Computer list. =
Create Sound Button

Click here to create a sound file
for use as the start-up sound,

Play Button
Click here to play the
selected sound

Delete Button
Click here to delete a
setting from the My

setting. Computer list. shutter sound, operation sound,
or self-timer sound.
*The utton is unavailable when you open the My
Came from the Camera Window.
eYou ca new data to the My Camera window. See Adding

New Data to the My Camera Window (p. 47).

Saving the My Camera Settings to the Camera

You can save the My Camera Settings displayed in the My Camera window to
the camera.
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Iﬁl My Camera Settings can be selected and saved in either of two
ways to the camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the
start-up image and animals calls in each of the sound files. The
names of the prepared files for the various My Camera Settings
themes all begin with the same root name, such as “Animal~".
For example, the start-up image that starts with “Animal~"
shows an animal picture while the similarly named sound files
feature animal sounds.

¢Settings that do not appear in the My Computer list of the My
Camera window cannot be saved to the camera.
Do not detach the USB cable, turn the camera power off or

disconnect the camera from the computer while the My Camera
Settings are being saved to the camera or the settings from the
camera are being saved to the computer.

1 Confirm that the [Setup as a theme] tab is selected in the My Camera
window.

To save the settings individually, select the [Set individually] tab and select
the setting type in the [Data Type] list box.

2 Sselect the settings file you wish to save to the camera from the My
Computer list.

If you are working in the [Setup as a theme] tab, the thumbnail (tiny
version) of the start-up image will display to the right and the sound files
will play in the order of start-up sound, shutter sound, operation sound and
self-timer sound.

3 Select the setting from the Camera list that you would like to change
and click [Save to Cameral.

This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this
category has previously been saved to the camera, it will be overwritten.

Repeat steps 1-3 as required.

To use this data on the camera, change the start-up image and sound
settings on the camera itself. Please see the Camera User Guide for these
instructions.

Saving the Camera’s My Camera Settings to the Computer

The My Camera Settings on the camera can be saved to the computer.



Adding New Data to the My Camera Window

My Camera Settings can be selected and saved in either of two
ways to the computer: individually or in theme sets.

Confirm that the [Setup as a theme] tab is selected in the My Camera
window.

To save the settings individually, select the [Set individually] tab and select
the setting type in the [Data Type] list box.

Select the settings file(s) from the Camera list that you wish to save
to the computer.

If you are working in the [Setup as a theme] tab, the thumbnail (tiny
version) of the start-up image will display to the right and the sound files
will play in the order of start-up sound, shutter sound, operation sound and
self-timer sound.

Click [Save to PC].

This concludes the process of saving the My Camera settings to the
computer.
Repeat steps 1-3 as required.

To add new data to the My Camera window, you need to create it, save it to the
computer and add that file to the My Camera window.

Create an Original Start-up Image File and then Add It

Start by creating the image file that will become the start-up image and save it
to the computer. Use an image editing program, such as ArcSoft
Photolmpression. Create the file in the JPEG format at a size of (w) 320 x (h) 240
pixels.

Once you have created the data and saved it to the computer, use the following
procedures to add it to the My Camera window.

Open the My Camera window, click the [Set individually] tab, select
[Startup Image] from [Data Type] and click the [Add File] button.

This will display the Open file dialog.

HORSERACZT_S501 Wity

IYASHIZT_SS07.wWal

FABLUKMOZ21_S507. WA
R

e

Add File: > Create Sound

[elete

Close
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2 Sclect the file you created and click [Open].

The selected file will appear in the Computer list.

This concludes the process for adding new data.

You can save the newly created data to the camera using the procedures
described in the Saving the My Camera Settings to the Camera section (p.
45).

To delete a setting, select the file name and click the [Delete]
button at the bottom of the My Computer list.

Create an Original Sound File and then Add It

The following example shows how to record and create a start-up sound file
using the My Camera Sound Maker window.
QuickTime is required to play the recorded sound.

1 Click [Camera & Memory Card] in the Main Window of ZoomBrowser
EX and select [My Camera Settings] in the next menu.

The My Camera Selection dialog will display.

2 Sselect [Start-up Image, Start-up Sound, Operation Sound, Selftimer
Sound and Shutter Sound] and click [OK].

The My Camera window will display.

3 Inthe My Camera window, select [Set individually], select a sound
type in the [Data Type] and click the [Create Sound] button in the My
Camera window.

The My Camera Sound Maker window will display.

JKIKORIZ1 517 e 3
Add File.. | Create Sound

Play El

Cloze

4 Click the tab of the sound file you will be creating, followed by the
[Record] button. Click the [Start_up Sound] tab in this example.

s My Camera Sound Maker

Start_up Sound Creating

Click. [Record] to record sound or click [Dpen] to open sound fie.
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To open a sound file already saved to the computer, click the
[Open] button in place of the [Record] button. Then skip to
Step 8.

5 click the [Start] button.

My Camera Sound Maker

Click start button to record.

(0 sec
@ = |

Recording will start.

6 \When the recording is complete, click the [Stop] button, followed by
the [Close] button.
Recording will stop after 30 seconds elapses even if the Stop button is not

clicked. In that case, just click the [Close] button.
The following window will appear.
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Volume Control —L & 'y

] —Hr— Finishing
g position of
i "*W sound (red
q il switch)
Starting positlion of Play Stop L—Rewind

sound (blue switch).

7 Click the [Sound Format] button as required and select a sound
format.

8 Edit the sound data so that it conforms to the time limits.

Adjust the time of the recording with the blue or red switch.
The extra data outside the starting and finishing switches can be erased by
clicking the [Cut] button.
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9 Click the [Save] tab, confirm that the sound file was created, input a
file name and then save it.

10 Click the [Save] button, add a file name and save it.

Repeats steps 4-10 as required to create sound files for the
shutter sound, operation sound and self-timer sound.

117 click @ to close the My Camera Sound Maker window.
12 Click the [Add File] button in the My Camera window.

HORSERACZ1_SI01.IPG T T
IYASHIZ1_SI0T.IPG

EABUKIYO21_SI0T.IPG
101.FG

I sadFie.. |

Cloze

In the Open dialog, select the file you created and click [Open].
The selected file will appear in the Computer list.

This concludes the process for adding a file to the My Camera settings. You
can add the file to the camera with the procedures described in the Saving
the My Camera Settings to the Camera section (p. 45).

ing chart shows
mera Sounds.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Using the Software on the
Macintosh Platform

This chapter explains the basic procedures for installing the software. Read this
material before you connect the camera to the computer for the first time.
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I Installing the Software

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

ltems to Prepare

eYour computer
e Canon Digital Camera Solution Disk supplied with the camera

Installation Procedures

Close any programs that are running.
Place the Canon Digital Camera Solution
Disk in the computer’s CD-ROM drive.

Double-click the CD-ROM icon, followed by
the [Mac OS X] and [Canon Digital Camera

iy
VR |
Installer] = icons.

With Mac OS 9, double-click the CD-ROM icon,
followed by the [Mac OS 9] and [Canon Digital

Camera Installer] @ icons.
The installer panel will display automatically.

Installer Panel

This will start the installation.
Follow the onscreen instructions to proceed with the installation.
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5 Remove the disk from the CD-ROM drive when
the installation is complete.

This concludes the software installation.
Continue by downloading images to the computer (p. 63).
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Using the Software on the
Macintosh Platform

This chapter explains the procedures for using ImageBrowser to download the
camera's images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software
on the Macintosh Platform - Preparations - section.
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I Starting ImageBrowser

Starting ImageBrowser

Begin by starting up ImageBrowser. The startup procedures vary according to
whether you are connecting the camera to the computer or using a memory
card reader.

Mac OS X

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication
with the computer.

e computer and
g vary between

Procedures for attaching the camera t
placing it in the correct mode for c
camera models. See Informatio
for details.

e,

iPhoto or Image Capture will automatically start when the camera and
computer are ready to connect. If either of these programs does not start,
proceed to Step 3.

2 Click ® at the upper left of the iPhoto or Image Capture window to

close it.
3 Double=lick the [Canon ImageBrowser] icon on the a
desktop. IPEX

If the Canon ImageBrowser icon does not appear on the (G s
desktop, double-click the [Canon Utilities] folder on the

drive on which the program was installed, followed by the [ImageBrowser]
folder and [ImageBrowser] icon.

4 Click [Canon Camera] in the Explorer View section.

Explorer View Section

The Communication Settings dialog will display.
This dialog will only appear for the first connection.
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5 Confirm that [USB port] is selected as the port option and that your
camera model name or [Canon Camera] are selected as the detected
camera. Click [Set].

Communication Settings

Port "USBPort

Your camera model
name or [Canon Camera]

and the USB port
. f_Cancel | number (e.g. @1) will

appear here.

Detected Camera [ XXX XX XXXXX %

iPhoto or Image Capture may automatically start up at the same time as the
Camera Window. Step 6 is not required when neither program starts up
automatically.

6 Click the @ icon at the top left of the iPhoto or Image Capture
window to close the program.

7 Confirm that the images from the camera are displayed as
thumbnails (tiny versions) in the Camera Window.

‘86 HXKKXXKKEX N

Thumbnail

BLEES
e

- e

Camera Windo




58

I Starting ImageBrowser

How to Set ImageBrowser to Start Automatically with Mac
0S X

You can have ImageBrowser start automatically when you connect the
camera to the computer by adjusting the following settings.

Mac OS X v10.2

1. Start Image Capture, click the [Image Capture] menu and select
[Preferences].

2. Select [Other] from the Camera Preferences list box.

'8 6 Image Capture Preferences
iPhoto

Camera Preferences v Image Capture
No application

When a camera is connected, open:

Scanner Preferences
When a scanner button is pressed, open: | Image Capture ! :]

[Tl Use TWAIN software whenever possible

3. Select [ImageBrowser] in the program selection window.
4. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Mac OS X v10.1
1. Start Image Capture and select [Other] from the Hot Plug Action list
box.

‘86 C Image Capture

i’ﬁ-,_a Download To: [ﬁc!ures, Movies, and Music folders M

Automatic Task: = None "ﬂ
Occurs after downloading

Hot Plug Actior v Image Capture Application I
5 None

2. Select [ImageBrowser] in the program selection window.
3. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Mac 0S 9
1 Attach the supplied USB cable to the computer’s USB port and the

camera’s Digital Terminal. Prepare the camera for communication
with the computer.

Procedures for attaching the camera to the computer and
placing it in the correct mode for connecting vary between
camera models. See Information about Your Camera (p. 91)
for details.




ImageBrowser will start and open the ImageBrowser Automation Wizard
dialog.

2 Confirm that [Display Images] is selected and click the [OK] button.

—————— ImageBrowser Automation wizard

Camera or memory card has been detected. Please select an action from
the following.

@ Display Images Confirm that this
© Download images option is selected.

(Vou can set the detailed settings in the dialogs that follow.)
Save to: Change...
Macintosh HDE:Documents:05_05_2002

 Launch Remote Capture

T ()

The Communication Settings dialog will display.
This dialog only appears the first time the camera is connected.

3 Confirm that [USB port] is selected as the port option and that your

camera model name or [Canon Camera] are selected as the detected
camera. Click [Set].

=——— Communication Settings =———

Port: USE Port ¥
Detected Camera —1  Your camera model name
or [Canon Camera] will
= appear here.

The Camera Window will open and display the camera images as
thumbnails (tiny versions).

@ O A oy S P
TN CRANEDT

oA

i MORALE sBE!

T P

Iﬁl In the ImageBrowser Automation Wizard dialog, you can
select the action that is carried out after ImageBrowser
starts.

59
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What to Do the Next Time ImageBrowser is Started

A dialog with the previously selected automated settings will display the
next time you start ImageBrowser. To use these settings unchanged,
click the [Start] button. To do nothing, click [Cancel]. To change the
settings, click [Settings change].

| wizard

Camera or memory card has been detected, The following action was
selected previousty. Doecute same action?

Display Images

wizard

Camera or memery card has been detected. Please select an action from

the following. y 4 N\
[__Cancel Q[ Settings change J1  start ||
# DNplay Images N 4
Q load images
u can set the detailed settings in the dialogs that fellow.)

5
Magntosh HDEDocuments05 05 2002
O Laghhch RemoteCapture
o

To change the settings, click [Settings Change] and select the desired action in
the ImageBrowser Automation Wizard dialog.

How to Set ImageBrowser to Not Start Automatically

1. Click the Apple menu & and select [Control Panels] and [Canon
ImageBrowser Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the check
mark.

3. Click the close box [0 at the upper left to close the window.

Click here to close the window. —fF= Settings for USB connection E]

| B4 The application program below will start.
Clear the check mark here to
stop ImageBrowser from

starting automatically. ';)"g::;"ss;;it'”" QUL

(O Select with the Dialog

Program Name: [ ImageBrowser 3 ]

Startup Program




A message asking whether you wish to continue the
connection may appear after some camera models are
connected to the computer. See Connection Confirmation
Message Displays (p. 117) in the Troubleshooting section
regarding this message.

Next, download images to the computer (p. 63).

Memory Card Connection

Insert the memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling
instructions.

Place the memory card in an
adapter if required.

Insert the loaded adapter
into the slot.

Start ImageBrowser.
Double-click the [Canon ImageBrowser] icon on the desktop.

o

=

5 :

(GO TS EBLOWSER Ui Innageb o' ssr
Mac OS X Mac OS 9

If the icon does not appear on the desktop, double-click the folder in which
you installed the program, followed by the [Canon Utilities] and
[ImageBrowser] folders and the [ImageBrowser] file.

61
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3 Double-click the [DCIM] folder in the Explorer View Section.

‘8006 LB

& Canon Camera
b B Macintosh HD Explorer View

= || canan pe .
b HE Section

The images from the memory card will display as thumbnails in the Camera
Window.

See Memory Card Fol T
about memory car uc

Next, download images to the computer (p. 63).

foriinformation
ile names.



Downloading Images to the Computer

Creating a Folder to Receive Downloaded Images

Create a new folder for downloaded images with the following procedures.

1 Click the window labeled [Browser Window] and bring it to the
foreground.

2 select the [Users] folder and the subfolder labeled with your user
name on the startup disk.

Mac OS 9 users should select [Macintosh HD] in the Explorer View section.
‘806

[§3 Canon Camera
<= =] Macintosh HD

13 A Applications
[ Desktop Folder
- 4 Users

3

‘ Explorer View Section

3 Click the [File] menu and select [New Folder].

Close ®|W
385
New Folder %N
licate
Send to Tras 86

RAY, image processing
This will create a folder labeled “Untitled.”

4 Input a new name and press the [return] key.
This will replace the name with the one you type.

|

Talals
£ [Travel
o T

% Documents

[ & Library
= Movies
& Music

[ Pictures

[ + Public i

63
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5 select the newly created folder.

‘8060
[ Canon Camera
= =4 Macintosh HD
[ 5 Applications
[ Desktop Folder
- & Users
- 4 john
[@E Desktop
| % Documents
[ & Library
= Movies
| & Music
[zl Pictures
[ | & Public
D
CB Travel 3

Downloading Images

Download images to the new folder.

1 Click the Camera Window to bring it to the forefront.
2 Click the images to download.
A blue frame appears around selected images.

‘80 XXXXKKXOK

Thumbnail

B @ o M |ls[B Bk B o B

SETUP CONNECT PRINT ref-ate IMAGE SLIDES
— — — Total: & images
“RAW" displays on RAW images. The movie icon displays on

movie thumbnails.

%u can select multiple images by holding the [shift] key
while clicking images.



Click [Download]:

SETUF COMNECT ' IMABE SLIES
OPTIONS  CAMERA  SELECT DELETE pownLoan | PRINT ROTATE  ypLoap HFO DPOF

Total: 6 images 7
The downloaded images will copy to the computer and appear in the
Browser Area.

‘8080 - Browser Windaw
‘i) Canon Camera

3

b |4 Apphcations (Mag
L] System Folder

- L8 Users

- A xxxrxxx

»

B Deskiop

— “RAW" displays

1 Document = L
. 3 Liraey I 100_0001 3G 100_0002_IPG 100_00031FG on RAW images'

Ll Movies

o Musi
- 3 Foturs — Browser Area
b L} iPhato

B Fawer
5 L # Public
(] ) Sites i L.
L Shared —— The movie icon

} @ oavaun displays on movie

thumbnails.

st e T
[ TRatin

| WORKS ‘ 100_ D004 PG
|
|

fp
o
Pl

G en need to install ImageBrowser.) However, there
are some inconveniences and limitations to this
downloading method. See the For Windows® XP and Mac
OS X Users leaflet or the Picture Transfer Protocol (PTP)
Mode leaflet for details.

Continue by printing out an image (p. 66).
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66 I Printing Images

Printing Images

1 select the image(s) you wish to print.
A blue frame appears around selected images.

Iﬁl Movie images cannot be printed.

2 Click the [Print] button and select [Layout printing] from the

displayed menu.

T A | |
\ Q Ze)

ICE EMNL #RGE DISPLAY IMAGE

Layout printing...

Index printing...

This displays the Layout Options dialog and the Print window.

Layout Options dialog Q,Q.Q e ==

layaut Options

How would you Wke 1o print your photos?

1 Custom layout printing

Y index printing
e
£y
n .'

) Fixed phatn size printing

Tied photo printing

“Frints each image at the indniduatly
specified size and position.

# Display this dialog when the Printing window displays

@ _ Canel (> )

0 | @ o

e WwEs LivouT
- PERPADE wrens PRI

Print window

3 Confirm that [Custom layout printing] is selected and click [Next].



Select settings, such as the paper size, and click [OK].

This will close the Layout Options dialog and allow you to change the

layout and print settings in the Print window.

Adjust the page layout in the Print window if yo

This conce printing process.

1anging layouts.
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68 I Printing Images

Print Window Features

When the [Custom layout printing] option is selected in the Layout Options
window, you can freely change the size and position of the images for printing.

‘806 Print

Flowers in the Mountain : Edit the Page Title

| Open the [Edit] menu
and select [Edit
Header].

Change the Image Size
Drag the border to
resize the image.

Change the Layout
Drag the images to
. change the layout.

Add Text
Open the [Edit] menu
I and select [Add Text].

Add Captions to Images

Change the default l Click the image and
number of images then the [Edit] menu
printed per page. i e - and select [Edit
owers in the Mountain | B.ption]!

n | l Displays the Layout

Reset the layout. ————— =5 &5 [ 4] 1% Options window.
ROThTE IMAGES LavouT PRNT

RESEATIITS w  FER PAGE | OPTIONS 4
Rotate the selected Displays the Print dialog.
image.

This chapter explained the ImageBrowser basics. Once you have mastered
them, read the following chapter to try the advanced techniques.

Using the Software on the Macintosh Platform - Advanced Techniques - (p.
69)

at manual for ImageBrowser is also available. It
s further information about the program's features
procedures. See Using the PDF Manuals (p. 109).
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Using the Software on the
Macintosh Platform

- Advanced Techniques -

This chapter explains how to use various ImageBrowser features, such as how to
play movies, create panoramic images and operate the camera shutter from the
computer.

Proceed to this chapter once you have mastered the basic ImageBrowser
procedures in the Using the Software on the Macintosh Platform - The Basics -
chapter.
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70 I Replaying Movies
I ° °
Replaying Movies
When you double-click an image with a movie icon in the ImageBrowser’s

Browser Area, QuickTime Player will start and replay the movie.

1 Double-click an image with a movie icon.
QuickTime Player will start.

2 Click the play button (P\ in QuickTime Player.
The movie will replay.

L] 883-8321_MVLAVI | E




Converting RAW Images - File Viewer
Utility

Images can be recorded in the RAW format (RAW images) with certain camera
models. RAW images are extremely high-quality images that are not degraded

by compression algorithms when recorded. However, they are not supported by
most image editing programs in their native format, so they must be converted
before use.

Use the File Viewer Utility to convert RAW images.

Iﬁl eSee Information about Your Camera (p. 91) to see if your camera
supports the RAW format.
eSee your Camera User Guide for the settings required to shoot

RAW images. 2

Converting RAW Format Images

1 Select a RAW image in ImageBrowser’s Browser Area.
2 From the [File] menu, Select [RAW image Processing].
This will start File Viewer Utility and display the selected RAW image.

3 Adjust the image quality as required.
See Image Adjustment features (p. 72) for instructions.

4 Click the [File] menu and select [Save File] and [Convert and save in
file].
This will display the Save File dialog.

5 sSelect a file destination and format for the image you wish to
convert.

You can save the image in the JPEG or TIFF format.

6 Click [OKI.
The utility will start to convert the image and save it to the computer.
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72 I Converting RAW Images - File Viewer Utility

File Viewer Utility Features

Preferences Button

Use this button to select
image transfer
applications. You can also
use it to adjust RAW image
processing settings.

selecting images.
| ‘a0e o Fils Voewer Litiliry r
o AT (CIETCED -
i Thumbnail display 18] [ Larp, ) | moocoooonoo: = 0 i .
3 i VersionInformation

P (ot setrings )| @ (oot sfuins i@ s

Save Button
Converts and saves the image.

Image Selection Button
Selects the method for
selecting images. Buttons for

Button

Displays the
program version
information.

Displays a
histogram
(distribution of
brightness data) for
the image.

| . .
Display Mode List Box Comment Box ﬁ\'}fg:?’astﬁgﬁ ':;?ge
Selects the thumbnail or A description of up to 60 :
preview display mode. characters can be input here.

Display Size List Box
Selects the size at which images display.

Image Adjustment Features

The following items will display when you select a RAW image and a camera

model name in the Model-Specific Processing Mode list box. You adjust the
image quality with them.

This section displays when a camera model

name is selected in the Model-Specific Model-Specific Processing Mode List Box
Processing Mode list box Selects the model of camera in use.
‘09086 & File Vidwer Utility
O EEEE R RE faffal BEEIE]
Thumbnail display  [5] [Large T X000 B { single-Frame Transfer

I_ [] Shot Settings =i 8]
L

A @ | shot Settings } :] ‘ P | shot Settings 3 | P | shot Settings
@b / shot Settings 2 | | |
J

Sets the Photo  Adjusts image Adjusts
Click this button and then a Effect mode. contrast. image color
white portion of an image . ) ) saturation.
to automatically adjust the Adjusts white balance settings.

white balance to that color. Adjusts the sharpness.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images, such as
those shot in the camera's Stitch Assist mode.
Use the PhotoStitch program to merge the images.

Starting PhotoStitch

Start PhotoStitch from ImageBrowser.

1 Sselect a series of images in the ImageBrowser’s Browser Area.
2 Click the [Edit] menu and select [PhotoStitch].
A window similar to that below will appear.

‘8086 PhotoStitch

Arrange Images
Click [Arrange] to select the merge direction when all the images are
loaded. ‘
Follow the instructions

= to merge the images.

1. Selection and Arrangement | 2. Merge

W

101—0002,\Mua,|...

No.of Images: 3 | 1600 1200TrusColor %

3 Merge the images following the instructions in the guidance panel
at the top of the PhotoStitch window.

s sh Stitc st mode with a wide converter,
e e or -up lens cannot be merged accurately.
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Images Shot in Stitch Assist Mode

It is easy to merge images shot with the camera's Stitch Assist mode since
PhotoStitch automatically arranges them in the correct order and orientation.
Stitch Assist mode images appear in the Camera Window as shown below.

Images shot in Stitch Assist mode display a mark
like this.

‘86 € XXXXXHXXXNX

e}
= g

IMAGE SLIDE/
INFO DPOF

® @& o M

SETUP CONMECT
OFTIONS  CAMERA SELECT DELETE

DowNLOAD  CRINT ROTATE " ppgan

Total: € image./

Iil eYou can also start Photo ark'shown on
images shot in Stitc
eSee the Camera

Stitch Assist

ut shooting in



Operating the Shutter Remotely -
RemoteCapture

You can use a computer to control the shutter of a connected camera to record
still images. This is particularly useful for checking images on the larger
computer display as you record them.

Start the RemoteCapture program to perform this task.

Starting RemoteCapture

Start RemoteCapture from ImageBrowser.

@ ¢Close the ImageBrowser Camera Window before starting
RemoteCapture.

*You cannot use RemoteCapture to shoot while the USB Mounter
(p. 87) is in use.

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal. Prepare the camera for communication

with the computer.
i cam o the c ter an
tm fo ecting v
m ut Your Came .91)

2 Close iPhoto or Image Capture if either program has started.

3 Open the lens cover or remove the lens cap on models equipped
with them.
Proceed to Step 4 if your model does not have one.

4 start ImageBrowser.

5 Click ImageBrowser’s [Edit] menu and select [RemoteCapture].

6 Click [Connect] when the "Connect to camera?" prompt appears.

The Communication Settings window will display. This window only
displays on the first connection.

7 Confirm that [USB port] is selected as the port option and that your
camera model name or [Canon Camera] are selected as the detected
camera. Click [Set].
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iPhoto or Image Capture may automatically start up at the same time. Skip
to Step 9 if neither program starts up.

8 Click the @ icon at the top left of the iPhoto or Image Capture
window to close the program.

9 Confirm that the Shooting-RemoteCapture window is displayed.

RemoteCapture Features

RemoteCapture has two windows: the Shooting-RemoteCapture window and
the Save-RemoteCapture window. Use these windows to record and save
images, respectively.

Shooting-RemoteCapture Window

Recordable Image Counter
Displays the number of images that will
fit onto the computer or memory card in

Detail Settings
The Detail Settings
dialog opens when

4 the camera.
you click the arrow
symbol on the left.
20 Shaoting - RemateCapture
Shots to Go Sive fQualipfl — =
11467 [arge/Fine ) %
fRGERTIoT - L e Release
{0 degres 7 —— Release Button
= Releases the
FAngle adum Shooting maties adjustment shutter
Viewfinder Display - Fogusing Point
Click the [Viewfinder Jmele 4
On] button while a i -, | Setthe basiccamera
. Rl A aisist light settings here.
connection to the on ]
camera is open to A sonalen.
display the image AF s effeciine
appearing in the
camera’s viewfinder. Sk o 0 F Rertecs chungss 3
Tajt Shar 3
Viewfinder On/Off ———— @ zn——— Slide this to zoom

the camera in or out.

Button IRABTIB G4 wAth Pace bar
Turns the viewfinder Reflect Changes Button
display on or off. Updates the settings.

- .
RemoteCapture locks the exposure and focus settings for the
subject matter in the Viewfinder section. If the lighting or
distance to the subject changes, click [Reflect changes] to reset
these settings.
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The following limitations apply when the Viewfinder image is

displayed with a DIGITAL ELPH/DIGITAL IXUS series camera.

*The Viewfinder will automatically turn off after you shoot or
after 1 minute passes after it is turned on. Click [Viewfinder On]
again to turn it back on. However, you may have to wait a

moment for it to come back on if the camera body temperature
has risen.

*The camera's LCD monitor does not display while the
Viewfinder is on. In addition, the Video OUT settings cannot be
set with RemoteCapture.

Save-RemoteCapture Window

Thumbnail View — —— Connect/Disconnect Button
Displays thumbnails Click here to open a connection to the camera and
of all the images display the RemoteCapture Shooting window. It will
shot after change to the Disconnect button while a connection is
RemoteCapture is open. Click it to close the connection.
started. ’

[N+ Save - RemateCapiure. B

View Button
Displays images
selected in the
Thumbnail View
area at a larger
size.

Delete Button
Deletes images
selected in the

-| Thumbnail View

'| area (completely
from the computer).
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Image Display Area Comments ———— Histogram
Displays the image Add a comment about the Check the distribution of
selected in the image here. brightness data here.

Thumbnail View.

Image Information
Check the image settings here.
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Shooting with RemoteCapture

If your computer is set to go into sleep mode, there is no
guarantee that RemoteCapture will continue to function after
the computer enters sleep mode. Always turn off the sleep
function before you start shooting with RemoteCapture.

1 Click the arrow to the left of [Detail Setting].
The full-view Shooting-RemoteCapture window will display.

2 Click [Viewfinder On] and view the image in the Shooting-
RemoteCapture window.

Change the settings if required. To update any changes made in the Detail
settings window, click the [Reflect changes] button.

3 Set the Size/Quality and Rotation settings in the Shooting-
RemoteCapture window.

You can save images of people and other subjects that are shot in portrait
orientation (camera held 90° on end) to the computer in the correct
viewing orientation by setting the [Rotation] category to [90 degrees left] or

[90 degrees right].
Capture o‘ ed if
he Auto Rot nction and

4 Click the [Release] button.

Images shot with RemoteCapture are automatically saved to the folder
selected in ImageBrowser.

so release the shutter by pressing the camera's

r button or the keyboard's space key.

e zoom controls and other camera buttons and switches,
except for the shutter button, cannot be operated while
RemoteCapture is controlling the camera.

*You may notice that the interval between the shutter
release and activation is slightly longer when
RemoteCapture is used to shoot than when the camera is
used in the normal fashion.



Interval Timer Shooting

Interval timer shooting is a method of shooting that records a specified number
of frames at set intervals.

1 In the Save-RemoteCapture window or Shooting-RemoteCapture
window, click the [File] menu and select [Interval Timer Shooting].

This will display the Interval Timer Shooting window.

2 Sset the number of frames and the interval value and click [Start].
This will record the specified number of frames at the specified interval.

Iﬁl eYou can set the time interval between 5 seconds to 60
minutes
eYou can capture up to the number of recordable frames
displayed in the Shooting-RemoteCapture ow (the
actual limit is 9999 frames when the di i
10,000 or higher).

Please note that the camera will not be able to shoot at the

specified interval if it is shorter than the time required to
transmit the data and save it to the computer.

Timer Shooting

Timer shooting is.a method of shooting that records a frame after a specified
number of seconds.

1 In the Save-RemoteCapture window or Shooting-RemoteCapture
window, click the [File] menu and select [Timer Shooting].

The Timer Shooting dialog will display.

2 Sset the timer interval and click [Start].
This will record an image after the specified time has elapsed.

Iﬁl You can specify a timer interval from 2 to 30 seconds.
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Other Preferences

Changing the File Destination and Method of Saving
1

Click the [RemoteCapture] menu (Mac OS X) or the [File] menu (Mac
0S 9) and select [Preferences] in the Save-RemoteCapture or
Shooting-RemoteCapture window.

This will display the Preferences dialog.

Select the way images are saved and the folder to which they are
saved and click [OK].

Preferences

[ File Settings | Release Hotkey |

Sets whether images are saved only to the
computer or to both the computer and the

Save Images On _

memory card in the camera. @ Computer anly
{ Memory card first, then computer
Input a root name for the image files here. If File Prefix — ,
H " " . to 16 characters
you input “Capture”, for example, the first g =
. . . Assign Sequence No.
image will be named [Capture_00001.jpg] [ Nimber of Digits ~ Sear
and successive images will automatically be | § =8
assigned a name that is one number higher — == =
than the last. e T
(select a Folder... )

. .
Cancel

Select a folder where images will be saved.

lecti Comput ly e"
S o shoot nt i
camera

en the era's

ges On" category
emory card in the
ory card is full.

Displaying the Subject in the Camera's LCD Monitor

You can view the subject you are shooting in the camera’s LCD monitor.

WN

In'the Shooting-RemoteCapture window, click the [File] menu and
select [Camera Display Settings].

The Camera Display Settings dialog will display.

Select [Camera’s LCD monitor] and click [OK].

In the Shooting-RemoteCapture window, click the [Viewfinder On]
button.
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Printing an Index of the Thumbnail Images

You can print an index of all the thumbnails displayed in the Thumbnail View
area of the Save-RemoteCapture window by clicking the [File] menu and
selecting [Print Index]. This provides a convenient register and means of
checking your images since the file name and shooting date are also printed
with each image.
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Enjoy Customizing Your Camera with the
My Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-
timer sound are called the My Camera Settings. You can add your favorite
images and sounds from your computer to the My Camera Settings in the
camera. This topic explains how to upload the My Camera Settings saved onto
your computer to the camera. Use ImageBrowser to perform this function.

Please check whether or not your camera model supports
this function. See Information about Your Camera (p. 91) for
details.

Displaying the My Camera Window

To save the My Camera Settings to the camera, you use the My Camera
window. The following explains the procedures for displaying the My Camera
window.

1 The Camera Window will open after you have connected the camera
to the computer and started ImageBrowser.

For starting instructions for ImageBrowser, see Starting ImageBrowser (p.
56).

2 Cclick [Setup Options] in the Camera Window and select [My Camera]
in the pop-up menu.

‘86 Camera Window.

[ 30GO XXX |
T
]
CONNECT
CAMERA SELECT DELETE

G

& rj L i
IMAGE SLIDES

FOTATE  pLoap INFO) DPOF

Camera Settings... 4

pownoap  FRIMT

The My Camera Selection dialog will display.



3 Select [Start-up Image, Start-up Sound, Operation Sound, Selftimer
Sound and Shutter Sound] and click [OK].

This will display the My Camera window.

ImageBrowser already contains several pre-recorded My
Camera Settings items. You can check these items with the
My Camera window.

The My Camera Window

Type
Select the My Camera
Settings type.

Displays the list
of My Camera
Settings files
saved onto the
computer.

Add Button
Click heretoadd =
a file as one of
the My Camera
Settings to the
My Computer list.

&

Play Button
Click here to play the
selected sound setting.

Type: | Theme

=

Save ToMacintosh HD:Wsers x

— Save to Camera
- Save to Computer

My Camera

3 |.'_'_1

Send to Trash Button
Click here to delete a
setting from the My
Computer list.

bocoonon Library Preferences ImagelirowserUserData

Play Button

Click here to play
sounds recorded onto
the camera.

= Displays the My
JCamara (Only editable iwems display) | Camera Settings in
: ‘ the camera.

Delete Button
Deletes a setting
from the Camera
list.

{ Saveto Comers ¥ Cloae—)

Save to Camera Button
Click here to save the
settings onto the
camera.

My Camera Settings to the My Camera
New Data to the My Camera Window (p.
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Saving the My Camera Settings to the Camera

You can save the My Camera Settings displayed in the My Camera window to
the camera.

Iﬁl My Camera Settings can be selected and saved in either of two
ways to the camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the
start-up image and animals calls in each of the sound files. The
names of the prepared files for the various My Camera Settings
themes all begin with the same root name, such as “Animal~".
For example, the start-up image that starts with “Animal~"
shows an animal picture while the similarly named sound files
feature animal sounds.

® eSettings that do not appear in the My Computer list of the My
Camera window cannot be saved to the camera.
*Do not detach the USB cable, turn the camera power off or

disconnect the camera from the computer while the My Camera
Settings are being saved to the camera or the settings from the
camera are being saved to the computer.

1 Confirm that the type of setting you wish to save to the camera is
selected in the Type list box.

2 Sselect the setting from the Computer list that you would like to add.

If you selected [Theme] in the Type category, the thumbnail (tiny version) of
the start-up image will display to the right and the sound files will play in
the order of start-up sound, shutter sound, operation sound and self-timer
sound.

3 Select the setting in the Camera list that you would like to change
and click the button.

The Camera list setting will change to the selected file. If a setting for this
category has previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

4 Click the [Save to Camera] button.

This concludes the process of saving the My Camera Settings to the
camera.

To use this data on the camera, change the start-up image and sound
settings on the camera itself. Please see the Camera User Guide for these
instructions.



Saving the Camera’s My Camera Settings to the Computer

The My Camera Settings on the camera can be saved to the computer.

My Camera Settings can be selected and saved in either of two
ways to the computer: individually or in theme sets.

1 Select the type of setting you wish to save to the camera from the
Type list box.

2 Select the setting in the Camera list that you wish to save to the
computer.

If you selected Theme in the Type category, the thumbnail (tiny version) of
the start-up image will display to the right and the sound files will play in
the order of start-up sound, shutter sound, operation sound and self-timer
sound.

Click the [ - | button.
Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera Settings to the
computer.

Adding New Data to the My Camera Window

To add new data to the My Camera window, you need to create the new data,
save it to the computer and add that file to the My Camera window.

h o

Create an Original Start-up Image File and then Add It

Start by creating the image file that will become the start-up image and save it
to the computer. Use an image editing program, such as ArcSoft
Photolmpression. Create the file in the JPEG format at a size of (w) 320 x (h) 240
pixels.

Once you have created the data and saved it to the computer, use the following
procedures to add it to the My Camera window.
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1 Open the My Camera window and click the [Add] button.
This will display the file opening dialog.

BASEBALLZ1_SI01.JPC
CHIMPANZ1_SIOL.JPC :

PC b4
£ Add.. ) 9 Send to Trash )
i

Play

Canon

Save ToMacintosh HD:Users:xxxxxxxx:Library:Preferences:ImageBrowserUserData: :
MyCameraFiles:SI_JPG:

N - =
@

2 Sclect the file you created and click [Open].
The selected file will appear in the Computer list.
This concludes the process for adding new data.
You can save the newly created data to the camera using the procedures
described in the Saving the My Camera Settings to the Camera section (p.

84).
To delete a setting, selec m d click the [Send to
Trash] button at the m o puter list.
.

Add an Original Sound File

Use a program such as ArcSoft Videolmpression to change the file format to the
WAV format after you have copied the sound file. Then proceed with the steps
on the previous page.

sound i e following chart shows
stand r My Camera Sounds.

Duration in Seconds
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Downloading Images with the USB
Mounter

The USB Mounter can only be used with the PowerShot G3, PowerShot $45 and
PowerShot $230 DIGITAL ELPH/DIGITAL IXUS v3 camera models on a computer
running Mac OS 9.

The USB Mounter is a driver program that allows images on a memory card in a
camera to be displayed on the desktop as if the camera were a card reader.
Images can be downloaded to the computer with the same procedures used to
copy images from a card reader.

The following actions cannot be taken while the USB Mounter is
in use.

eStarting ImageBrowser automatically (when the USB cable is
connected).

eUsing ImageBrowser to adjust camera settings.

*Shooting with RemoteCapture.

eDeleting images from the camera.
*Uploading images from the.computer to the camera.

Enabling the USB Mounter

To download images with the USB Mounter, first enable it with the following
procedures.

1 Select [Control Panels] from the Apple menu % and [Canon USB
Camera Driver].

The Canon USB Camera Driver control panel will display.

2 Sselect [Card Reader Mode] and close the control panel.

Click here to close it. = Canon USB Camera Driver =
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) Camera Mode

@ Card Reader Mode

The changes will become effective
& after restarting the computer.

A dialog prompting you to restart the computer will display.
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I Downloading Images with the USB Mounter

3 Click [Yes] to restart the computer.
The USB Mounter will be enabled.

Disable the USB Mounter when you need to upload images
to the camera or shoot with RemoteCapture.
1. Select [Control Panels] from the Apple menu = and
[Canon USB Camera Driver].
The Canon USB Camera Driver control panel will display.
2. Select [Camera Mode] and close the control panel.
After you restart the computer, the USB Mounter will be
disabled.

Downloading Images

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal.

Procedures for attaching t
placing it in the correc

camera models. Se jo
for details. A
The camera icon will display on the desktop.

2 Double-click the camera icon.

a‘ Camera lcon
B e Your camera model

name will appear here.

3 Select the folder containing the images.

The images on the memory card will display as file icons.
See Memory Card Folder Structure (p. 115) for information about memory
card folder structures and file names.

4 Copy images to the computer’s hard disk using standard file copying
procedures.

Select images and drag and drop them onto the target folder on the
computer to download them.

Never turn off the power or detach the USB cable while
copying. The equipment may not operate correctly.



89

Macintosh - Advanced Techniques -







Information about Your Camera

The software package and the procedures for connecting to a computer and
preparing for data transfers vary between camera models. Certain software
functions may also not be supported by some camera models.

Read this section to confirm the capabilities of your camera model.
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I Information Common to All Models

Information Common to All Models

See the respective page for your camera model for information specific to that
model (pp. 94 - 101).

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all
models. It contains the following programs.

Compatible Operating System

Program Windows Macintosh
98 Me | 2000 | XP A 9 0s X

ZoomBrowser EX o —_
ImageBrowser - [ )
TWAIN Driver [} - () - -

WIA Driver - o —_ —_1 -

USB Mounter —_ [ -
File Viewer Utility o (]
PhotoRecord o -
PhotoStitch [ ()
RemoteCapture @ (]

*1: The WIA Driver is supplied for the PowerShot G3, PowerShot 545 and
PowerShot $S230 DIGITAL ELPH/DIGITAL IXUS v3 models only.

*2: Only compatible with the PowerShot G3, PowerShot S45 and PowerShot
$230 DIGITAL ELPH/DIGITAL IXUS v3 models.



Connecting the Camera to a Computer

Ensure that you have installed the software from the supplied
Canon Digital Camera Solution Disk before you connect the
camera to the computer.

eYour camera and computer
e USB cable supplied with the camera

eUse the USB cable to attach the camera directly to a USB port on
the computer, not through a USB hub. The connection may not
operate correctly through a USB hub.

*The connection may not operate correctly if you are using other
USB devices, excluding USB mice or keyboards, at the same time
as the camera. If this occurs, disconnect the other devices from
the computer and try reconnecting the camera.

*Do not connect two or more cameras to the same computer via
the USB interface. The connections may not operate correctly.

*Never allow the computer to go into standby (sleep) mode while
a camera is connected via the USB interface. If it does happen,
never disconnect the USB.cable. Try to awaken the computer
with the camera in the connected state. Some computers will
not awaken properly if you disconnect the camera while they
are in standby (sleep) mode. Please refer to your computer
manual forinstructions regarding the standby (sleep) mode.

to po the rom a household
r source (AC er) ng to a computer.

See the page (pp. 94 - 101) for your specific model for information about
connecting the camera to the computer.
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I PowerShot S50

PowerShot $50

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal as shown below.

USB Port

To the Digital
Terminal

USB Cable

1. Slip a fingernail under the terminal
cover and lift to open.
2. Insert it all the way until it clicks.

The camera and computer will automatically be ready to transfer data when a
connection is established.

CD-ROM:s in the Package

eCanon Digital Camera Solution Disk

¢ ArcSoft Camera Suite 2.0
See ArcSoft Camera Suite 2.0 CD-ROM (p. 104) for information about the
features and installation procedures for the programs on the disk.

Non-Supporied Programs and Features

USB Mounter (Macintosh) is not supported.
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PowerShot $400 DIGITAL ELPH/DIGITAL
IXUS 400

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal as shown below.
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USB Port To the Digital
Terminal

1. Slip a fingernail under the
terminal cover and lift to open.
2. Insert it all the way until it clicks.

USB Cable

2 Set the mode switch to the replay mode and turn the camera’s
power on. This will prepare the camera to exchange data with the
computer.

CD-ROM:s in the Package

e Canon Digital Camera Solution Disk

¢ ArcSoft Camera Suite 1.2
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the
features and installation procedures for the programs on the disk.

Non-Supported Programs and Features

*RAW images cannot be recorded.
*USB Mounter (Macintosh) is not supported.
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PowerShot A70

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal as shown below.

USB Port

To the Digital
Terminal

1. Open the terminal cover by slipping a
fingernail in the groove and lifting.
2. Insert it all the way until it clicks.

USB Cable

2 set the mode switch to the replay mode and turn the camera’s
power on. This will prepare the camera to exchange data with the
computer.

CD-ROMs in the Package

eCanon Digital Camera Solution Disk

¢ ArcSoft Camera Suite 1.2
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the
features and installation procedures for the programs on the disk.

Non-Supporied Programs and Features

*RAW images cannot be recorded.
*USB Mounter (Macintosh) is not supported.



PowerShot A60

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal as shown below.

USB Port

To the Digital
Terminal

1. Open the terminal cover by slipping a
fingernail in the groove and lifting.
2. Insert it all the way until it clicks.

USB Cable

2 set the mode switch to the replay mode and turn the camera’s
power on. This will prepare the camera to exchange data with the
computer.

CD-ROM:s in the Package

e Canon Digital Camera Solution Disk

¢ ArcSoft Camera Suite 1.2
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the
features and installation procedures for the programs on the disk.

Non-Supported Programs and Features

*RAW images cannot be recorded.
*USB Mounter (Macintosh) is not supported.
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98 I PowerShot A300

PowerShot A300

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal as shown below.

USB Port

To the Digital
Terminal

USB Cable

USB Cable

1. Open the terminal cover by slipping a
fingernail in the groove and lifting.
2. Insert it all the way until it clicks.

2 Pressthe [ (On) button. This will prepare the camera to exchange
data with the computer.

CD-ROM:s in the Package

eCanon Digital Camera Solution Disk

¢ ArcSoft Camera Suite 1.2
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the
features and installation procedures for the programs on the disk.

Non-Supported Programs and Features

*RAW images cannot be recorded.
*USB Mounter (Macintosh) is not supported.

*The camera's LCD monitor will not display images and the Video OUT
settings cannot be set while the Viewfinder function is on in the
Shooting-RemoteCapture window of RemoteCapture.



PowerShot G3

1 Confirm that the camera’s [Communication] setting is set to
[Normall.

See the Camera User Guide for information about the
camera’s Communication settings.

2 Attach the supplied USB cable to the computer’s USB port and the
camera'’s Digital terminal as shown below.

USB Port

To the Digital
Terminal

USB Cable

USB Cable

1. Open the terminal cover by slipping a
fingernail in the groove and lifting.
2. Insert it all the way until it clicks.

The camera and computer will automatically be ready to transfer data
when a connection is established.

CD-ROM:s in the Package

eCanon Digital Camera Solution Disk

¢ Adobe Photoshop 5.0 LE
See Adobe Photoshop 5.0 LE CD-ROM (p. 108) for information about the
features and installation procedures for the programs on the disk.

Non-Supported Programs and Features

All programs and features are supported
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I PowerShot S45

PowerShot $45

1 Confirm that the camera’s [Communication] setting is set to
[Normall.

See the Camera User Guide for information about the
camera’s [Communication] settings.

2 Attach the supplied USB cable to the computer’s USB port and the
camera'’s Digital terminal as shown below.

USB Port

To the Digital
Terminal

USB Cable

4]
H\

USB Cable

1. Slip a fingernail under the terminal
cover and lift to open.
2. Insert it all the way until it clicks.

The camera and computer will automatically be ready to transfer data
when a connection is established.

CD-ROM:s in the Package

e Canon Digital Camera Solution Disk

¢ ArcSoft Camera Suite 2.0
See ArcSoft Camera Suite 2.0 CD-ROM (p. 104) for information about the
features and installation procedures for the programs on the disk.

Non-Supported Programs and Features

All programs and features are supported



PowerShot $230 DIGITAL ELPH/DIGITAL
IXUS v:

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Confirm that the camera’s [Communication] setting is set to
[Normal].

See the Camera User Guide for information about the
camera’s [Communication] settings.

2 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital terminal as shown below.

USB Port DIGITAL ¢ A/V OUT Terminal

1. Slip a fingernail
under the terminal
cover and lift to
open.

USB Cable

USB Cable 2. Insert the connector with the p symbols on

the camera and cable aligned.

3 Set the mode switch to the replay mode and turn the camera’s
power on. This will prepare the camera to exchange data with the
computer.

CD-ROM:s in the Package

e Canon Digital Camera Solution Disk

e ArcSoft Camera Suite 1.2
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the
features and installation procedures for the programs on the disk.

Non-Supported Programs and Features

*RAW images cannot be recorded.
eThe My Camera function is not supported.
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Appendices

This chapter introduces the CD-ROMs included in your package and the
procedures for installing the programs. It also explains how to uninstall the
programs.

Read the Troubleshooting section in this chapter if you experience a problem
using the programs.
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About the CD-ROMs in Your Package

CD-ROM s containing image editing programs are included in your camera
package along with the Canon Digital Camera Solution Disk. This topic explains
the program features and installation procedures for each CD-ROM.

The CD-ROMs supplied with the cameras differ by model. See
Information about Your Camera for details (p. 91).

ArcSoft Camera Suite 2.0 CD-ROM

This CD-ROM contains the following programs.

Compatible Operating System
Program Windows Macintosh
98 Me | 2000 | XP 0s9 0OS X
ArcSoft
PhotoStudio ® o
ArcSoft
Videolmpression o o

The free hard disk space required to install ArcSoft Camera Suite 2.0 is 250 MB
or more on a Windows systemand 150 MB or more on a Macintosh system.

What Can Be Accomplished with ArcSoft Camera Suite 2.0
Special Effects and Image Editing for Various Purposes

¢ ArcSoft PhotoStudio

This program can be used to correct colors or brightness levels, apply special
effects, and edit and print images. ArcSoft PhotoStudio is Arcsoft, Inc.’s high-
performance, user-friendly image editing program.

Programs for Editing Stills and Movies

¢ ArcSoft Videolmpression
This program provides simple procedures for compiling a movie from multiple
clips or stills and for editing out unwanted frames from movies.



Installing ArcSoft Camera Suite 2.0

Windows

Place the ArcSoft Camera Suite CD-ROM in the drive.

Follow the onscreen messages to install PhotoStudio and Videolmpression.
If the message does not appear automatically, click the Windows [Start]
menu, select [My Computer], and double-click the [ARCSOFT] and
[Setup.exe] icons EN.

Windows 2000, Windows Me and Windows 98 users should double-click
the [My Computer] icon on the desktop, followed by the [ARCSOFT] and
[Setup.exe] icons EN.

Macintosh
eInstalling ArcSoft PhotoStudio

3

Close all programs that are running.
Place the ArcSoft Camera Suite CD-ROM in the drive.

Open the CD-ROM window and double-click the [PhotoStudio 4],
[English] and [PhotoStudio Installer] icons @ .

Installation will start.
Follow the onscreen messages to proceed with the installation.

Click [Finish] when the message stating that the installation is
complete appears.

Continue by installing ArcSoft Videolmpression.

eInstalling ArcSoft Videolmpression

In the CD-ROM window, double-click the [Videolmpression 1.6],
[English] and [Videolmpression 1.6 Installer] icons ‘LE .
Installation will start.

Follow the onscreen messages to proceed with the installation.

Restart the computer after the installation is complete.

This concludes the installation process for ArcSoft PhotoStudio and ArcSoft
Videolmpression.
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ArcSoft Camera Suite 1.2 CD-ROM

This CD-ROM contains the following programs.

Compatible Operating System

Program Windows Macintosh

98 Me | 2000 XP 0s9 oS X

ArcSoft
Photolmpression

ArcSoft
Videolmpression

The free hard disk space required to install ArcSoft Camera Suite 1.2 is 475 MB
or more on a Windows system and 375 MB or more on a Macintosh system.

What Can Be Accomplished with ArcSoft Camera Suite 1.2
Special Effects and Image Editing for Various Purposes

¢ ArcSoft Photolmpression
This program can be used to apply special effects, and edit and print images in
simple steps. It can also be used to create postcards and calendars.

Programs for Editing Stills and Movies

¢ ArcSoft Videolmpression
This program provides simple procedures for compiling a movie from multiple
clips or stills and for editing out unwanted frames from movies.

Installing ArcSoft Camera Suite 1.2

Windows

T Place the ArcSoft Camera Suite CD-ROM in the drive.

Follow the onscreen messages to install Photolmpression and
Videolmpression.

If the message does not appear automatically, click the Windows [Start]
menu, select [My Computer], and double-click the [ARCSOFT] and

[Setup.exe] icons EX.
Windows 2000, Windows Me and Windows 98 users should double-click
the [My Computer] icon on the desktop, followed by the [ARCSOFT] and

[Setup.exe] icons EX .



Macintosh
eInstalling ArcSoft Photolmpression

3

Close all programs that are running.
Place the ArcSoft Camera Suite CD-ROM in the drive.

Open the CD-ROM window and double-click the [Photolmpression
4], [English] and [Photolmpression Installer] icons @

Installation will start.
Follow the onscreen messages to proceed with the installation.

Click [Finish] when the message stating that the installation is
complete appears.

Continue by installing ArcSoft Videolmpression.

eInstalling ArcSoft Videolmpression

In the CD-ROM window, double-click the [Videolmpression 1.6],
[English] and [Videolmpression 1.6 Installer] icons ‘L

Installation will start.
Follow the onscreen messages to proceed with the installation.

Restart the computer after the installation is complete.

This concludes the installation process for ArcSoft Photolmpression and
ArcSoft Videolmpression.
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Adobe Photoshop 5.0 LE CD-ROM

This CD-ROM contains the following programs

Compatible Operating System
Program Windows Macintosh
98 Me | 2000 | XP 0S9 0OS X
Adobe Photoshop
5.0 LE o o -

Approximately 40 MB or free hard disk space is required to install Adobe
Photoshop 5.0 LE.

What Can Be Accomplished with Adobe Photoshop 5.0 LE

Special Effects and Image Editing for Various Purposes

This program can be used to correct colors or brightness levels, apply special
effects, and edit and print images. Photoshop 5.0 LE is a limited edition of
Adobe Systems Inc.’s popular Photoshop program, the standard for image
editing programs.

Installing Adobe Photoshop 5.0 LE

You are required te input a serial number when installing Adobe

Photoshop 5.0 LE. Use [SDM501B4164785-650], orthe serial
number on the CD-ROM case if one is listed there.

Windows

1 Place the Adobe Photoshop 5.0 LE CD-ROM in the computer’s CD-
ROM drive.

2 Click the [Start] menu, select [My Computer], [Photosle], [English],
[Photosle] and [Setup.exe] icons g .

For Windows 2000, Windows Me, and Windows 98, double-click the [My
Computer] icon on the desktop, [Photosle], [English], [Photosle] folder, and
the [Setup.exe] icon in succession.

Follow the onscreen messages to proceed.



109
Macintosh

1 Close any programs that are running.

2 Place the Adobe Photoshop 5.0 LE CD-ROM in the computer’s CD-
ROM drive.

3 Double-lick the CD-ROM icon, followed by the [English] and [Adobe
Photoshop 5.0 LE] folders and the [Install Photoshop LE] icon .
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The installation will start.

Using the PDF Manuals

The following PDF-format manuals (hereafter PDF manuals) are provided
to explain the features and procedures for using ZoomBrowser EX and
ImageBrowser.

e ZoomBrowser EX Software User Guide (Windows)

¢ ImageBrowser Software User Guide (Macintosh)

Adobe Acrobat Reader must be installed to read the

aforementioned PDF manuals.

Viewing PDF Manuals

Viewing Manuals Downloaded from a Website
These PDF-format manuals are available on the Canon website. Use your
browser program to download these manuals from the following URL:

http://www.canon.co.jp/Imaging/information-e.html/
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to
delete the programs from your computer or when reinstallation is required to fix
corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a
program.

1 Click the Windows [Start] menu and select [Programs] or [All
Programs], followed by [Canon Utilities], [ZoomBrowser EX] and
[Uninstall ZoomBrowser EX].

The uninstall utility will start and remove ZoomBrowser EX.

T
eYou C emove O

Phot ord ¢

rograms with the same procedures.
uninstalled by clicking the Windows

d selecting [Programs] or [All Programs],
[Canon PhotoRecord] and [Uninstall

Ph



Uninstalling the Other Supplied Programs

¢ ArcSoft PhotoStudio, Photolmpression and Videolmpression
Uninstall these programs by clicking the Windows [Start] menu and selecting
[Programs] or [All Programs], followed by [ArcSoft Camera Suite] and
[Uninstall].

e Adobe Photoshop 5.0 LE
Uninstall the program by clicking the Windows [Start] menu and selecting
[Programs] or [All Programs], followed by [Adobe], [Photoshop Limited Edition]
and [Uninstall Photoshop Limited Edition].

Uninstalling the USB Driver (Windows)

Use the following procedures to uninstall the USB Driver.

It is essential to note that you will not be able to download
images if you uninstall the USB Driver.

This procedure is not require
other than the PowerSho
$230 DIGITAL ELPH/DI

1 Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication
with the computer.

For USB cable connection instructions, see Information about Your Camera

(p. 91).
A dialog allowing you to select which application program to start will
display.

2 Click the [Cancel] button.
If ZoomBrowser EX is started, close it.
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3 Windows XP: click the [Start] menu and select [Control Panel],
followed by [Printers and Other Hardware].
Windows 2000, Windows Me and Windows 98 users should click the
[Start] menu and select [Settings], followed by [Control Panel].

Pick a category
F‘ Apge s siwe sl Them ¢ g rmmﬂllﬁ!!llﬁ:.!

‘-'" etk bk rvnad e —
F e “ e
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4 Click the [Scanners and Cameras] icon or folder.

?‘ Prindirs e (18 Hardmars

Pick a task...

L

3] Ase g

5 Delete your camera model name or [Canon Camera] in the [Scanners
and Cameras] folder.

Windows 2000 and Windows 98 users should delete your camera model
name or [Canon Camera] in the [Scanners and Cameras Properties] dialog.

-"‘" " okl ¥
[« §I1u‘t"l£% roidees [T~

T T 1]

Your camera model name or
[Canon Camera] will appear here.

By Tanks

(M Add o rar derms
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Windows XP/Windows Me
Select your camera model name, right-click the mouse and select [Delete].

Windows 2000/Windows 98
Select your camera model name or [Canon Camera] and click [Remove].

If your camera model name does not appear here, see the
Camera not detected, Events dialog won‘t display or images
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will not download to the computer (p. 118) of the
Troubleshooting section.

Click the Windows [Start] menu and select [Programs] or [All
Programs], followed by [Canon Utilities], [Camera TWAIN Driver x.x]
and [Uninstall TWAIN Driver]. (A version number appears in place of
the “x.x".

Models Other Than the PowerShot G3, PowerShot S45 and
PowerShot 5230 DIGITAL ELPH/DIGITAL IXUS v3
e Windows 2000, Windows 98: Perform Step 6 with no substitutions.
¢ Windows Me: Substitute the following for the underlined portions of
Step 6.
[Camera WIA Driver x.x], [Uninstall WIA Driver]

PowerShot G3, PowerShot S45 and PowerShot S230 DIGITAL ELPH/

DIGITAL IXUS v3

Substitute the following for the underlined portions of Step 6.

e PowerShot G3: [PowerShot G3 TWAIN Driver] or [PowerShot G3 WIA
Driver], [Uninstall TWAIN Driver] or [Uninstall WIA Driver].

e PowerShot S45: [PowerShot S45 TWAIN Driver] or [PowerShot S45 WIA
Driver], [Uninstall TWAIN Driver] or [Uninstall WIA Driver].

e PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3: [IXY 320, PowerShot
$230, IXUS v3 TWAIN Driver] or [IXY 320, PowerShot 5230, IXUS v3 WIA
Driver], [Uninstall TWAIN Driver] or [Uninstall WIA Driver].

The uninstall process will start.

To connect the camera to the computer and download after this point, use
the following procedures.

1. Reinstall the driver.

2. Connect the camera to the computer with the USB cable.
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Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which
it was installed) into the Trash.

Please be careful not to accidentally delete any folders with

downloaded images that may be contained within the
application folder.

To learn how to uninstall the USB Mounter, double-click the
[Canon Digital Camera Solution Disk] CD-ROM icon, followed by

the [Mac OS 9], [Readme] and [English] folders, and open the
[Mounter ReadMe] file.



Memory Card Folder Structure

The images on a memory card are placed in the [DCIM] folder in subfolders
labeled [xxxCANON], where the “xxx"” represents a number in the range 100 -
998.

— IMG_xxxx.JPG (JPEG format images)
EI —— CRW_xxxx.CRW (RAW format images)
*
DCIM YXXxCANON —— CRW_xxxx.THM

L STX_xxxx.JPG** (Stitch Assist mode
images)

—— MVI_xxxx.AVI (Movies)

—— MVI_xxxx.THM*

L SND_xxxx.WAV (Sound annotation)

EI The folder that holds the settings files for
images in the DCIM folder.
CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC

e *Files with the THM extension are the thumbnail image files for the camera’s
index replay mode.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting
from “A,” which is inserted as the third digit in the name. i.e.
[STA_0001.JPG], [STB_0002.JPG], [STC_0003.JPG] ...

*The “xxxx" in file names represent four-digit numbers.

e All folders except the “xxxCANON" folders contain image settings files. Do not
open or delete them.
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

? Does your computer meet the following requirements?

Computer systems that fail to meet the following requirements to

accommodate a camera connected by a USB cable are not

supported. Please acquire the necessary system.

e Built-in USB port on a system pre-installed with Windows XP, Windows
2000, Windows Me, or Windows 98 (First or Second Edition)

e System with a genuine Apple Computer built-in USB port

@ Is the camera correctly connected to the computer?

o
See Information about Your Camera (pp. 94-101) for the correct
connection procedures. Also check to ensure that you are using the
correct cable and that it is securely attached at both ends.

Is the camera’s Communication setting set to [Normal]? (PowerShot
G3, PowerShot S45 and PowerShot S230 DIGITAL ELPH/DIGITAL
IXUS v3 only)

),

Set the [Communication] setting set to [Normal]. See the Camera
User Guide for information about changing communication
settings.

? Is the camera set to the replay mode? (some models only)

Some models require the camera to be set to the replay mode to
transfer data. See Information about Your Camera (pp. 94-101) for
details.

@ Is the battery sufficiently charged?

Q
Check the battery charge if you are powering the camera with a
battery. You are recommended to use a household power source
(AC adapter) to power the camera when it is connected to a
computer.



Problems

Try the suggested solutions to the common problems listed below.

USB Driver installation not proceeding well (Windows)

Uninstall the driver (p. 111) before reinstalling it with the procedures in
Installing the Software and USB Driver (p. 10).

@ Add New Hardware Wizard or New Hardware Found (Windows
g 2000) Wizard displays when the camera is connected to the
computer with a USB cable.

Click [Cancel] to close the window. Temporarily disconnect the camera
from the computer. Next, read Start by Checking This on the previous page
and resolve the problem.

@ Connection confirmation message displays. (PowerShot G3,
g PowerShot 545 and PowerShot $230 DIGITAL ELPH/DIGITAL IXUS v3
only)

Cause:

The camera’s [Auto Power Down] function is set to [On]. This
message displays if you do not access a function for a set period of
time (5 minutes) while the camera is connected to the computer via
the USB cable.

Solution 1:

Select one of the options in the dialog. The connection to the camera will
close after 1 more minute if you do not act. See the Camera User Guide for
instructions how to reactivate the camera if this occurs.

Solution 2:
Set the camera’s [Auto Power Down] function to [Off]. See the Camera
User Guide.
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?

Q

Camera not detected, Events dialog won't display or images will
not download to the computer (when camera is connected to the
computer via a USB cable)

Cause 1:

There is a problem with one of the items in the Start by Checking
This section (p. 116).

Solution:
Resolve the problem.

Cause 2:

The USB Driver is not installed. (Windows only)

Solution:
Install it with the procedures in Installing the Software and USB Driver (p.
10).

Cause 3:

The USB Driver is not correctly installed. (Windows only)

Solution:
Uninstall the driver (p. 111) before reinstalling it with the procedures in
Installing the Software and USB Driver (p. 10).

Cause 4:

The camera may have been recognized as another device under the

following circumstances. (Windows only)

® The camera was connected to the computer before the USB Driver was
installed.

¢ The [Scanners and Cameras] icon or the [Scanners and Cameras] folder
cannot be found in the [Control Panel] or the [Printers and Other
Hardware] window.

¢ Your camera model name, [Canon Camera] or a camera icon does not
display in the [Scanners and Cameras Properties] dialog or the [Scanners
and Cameras] folder.

Solution 1:

Start with the following procedures.

Install the USB Driver with the procedures in Installing the Software and
USB Driver (p. 10). Then connect the camera to the computer with the USB
cable and prepare it to transfer data (p. 15). If the USB Driver is already
installed, uninstall it first and then reinstall it.



Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue

by implementing the following procedures. The specific steps are explained

below.

1. Check to see if the camera is being recognized as an “other” device.

2. Delete the driver and the setup information files if it is being recognized
as an “other” device.

3. Reinstall the driver.

This section explains the specific steps for each operating system.
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Windows XP and Windows 2000

Users of Windows XP.Professional and Windows 2000 must

first log in as an Administrator (computer system
administrator) to delete a driver.

<Check to see if the camera is being recognized as an “other”
device and delete the driver if it is.>

1. Windows XP: Click the [Start] menu, followed by [Control Panel],
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and
[Control Panel]. Double-click the [System] icon.

. Click the [Hardware] tab, followed by [Device Manager].

. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in
these categories if it is being recognized as an “other” device.
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4. Select your camera model name or [Canon Camera], right-click and
select [Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it

appears in one or more places in the [Other devices] or [Imaging devices]
categories.

6. Close the [System Properties] window.

Step 7 and above are not required for Windows XP with
cameras other than the PowerShot G3, PowerShot S45 and
PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3.
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< Delete the setup information files>

7. Windows XP: Click the [Start] menu and open [My Computer],
followed by [C:] Drive, the [Windows] folder and the [Inf] folder.
Windows 2000: Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, [Winnt] folder and [Inf] folder.
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If the [Inf] Folder Is Not Visible in the [Winnt] or [Windows]
Folder
Use the following procedures to show all files and folders.

. Open the [Winnt] or [Windows] folder.

. Click the [Tools] menu and select [Folder Options].

. Click the [View] tab.

. In the [Files and Folders] category in the Advanced Settings section,
set [Hidden files and folders] to [Show hidden files and folders].
Remove the check marks from the [Hide extensions for known file
types] or [Hide file extensions for know file types] if it is present.

5. Click [OK] to close the dialog.

AWN —

This will make the hidden files and folders visible.
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8. Look for files for Canon digital cameras that start with [Oem*].
The “*" represents a number, such as 0 or 1.

[Oem*] files come in pairs of [Oem*.inf] and [Oem*.pnf] files. (For
example, [Oem0.inf] and [OemO0.pnf]).

9. Double-click the [Oem*] files to check their contents.
Double-clicking an [Oem*] file will open it in the Windows Notepad
program. Look for [;***Canon Camera Driver Setup File****] in the
first line. Note down the names of these files.
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Several sets of [Oem*] files may be present in the [Inf]
folder. Open up each file to confirm that it is an [Oem*] file

for Canon digital cameras before you do anything with the
file.

10.Delete the [Oem*] file set.

Delete the [Oem*.inf] and [Oem*.pnf] file for Canon digital cameras
that you noted down in Step 9.

The Inf folder contains numerous files critical to the
computer’s operation. Be extremely careful to delete the

correct files. If you delete the wrong files, you may be
unable to restart Windows.

<Reinstall the driver.>

11.Reinstall the driver with the procedures in Installing the Software and
USB Driver (p. 10).



123
Windows Me/Windows 98

<Check to see if the camera is being recognized as an “other”
device and delete the driver if it is.>

1. Click the [Start] menu and select [Settings], followed by [Control Panel].
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.

3. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in of
these categories if it is being recognized as an “other” device.
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. Select your camera model name or [Canon Camera] and click [Remove].

. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

6. Click [OK] to close the System Properties window.

gl

< Delete the setup information files.>

7. Double-click the [My Computer] icon on the desktop, followed by the
[C:] drive, [Windows] folder and [Inf] folder.
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If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. Windows 98: Set the [Hide files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show
hidden files and folders].

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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8. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
9. In the [Inf] folder, double-click the [Other] folder to open it.
10. Find and delete the [Canon.IncCAP_xxx.Inf] file. (The xxx

represents numerals or letters.)
For the PowerShot G3, PowerShot S45 and PowerShot
S230 DIGITAL ELPH/DIGITAL IXUS v3 models, find and
delete the [Canon.IncCAP_G3.Inf], [Canon.IncCAP_S45.Inf] or
[Canon.IncCAP_S230.Inf] file.

You do not need to delete anything if none of the above
files are contained in the [Other] folder.
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The [Inf] folder contains numerous files critical to the
computer’s operation. Be extremely careful to delete the

correct files. If you delete the wrong files, you may be
unable to restart Windows.

<Reinstall the driver>
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11.Reinstall the driver with the procedures in Installing the Software and
USB Driver (p. 10).

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in
ZoomBrowser EX to slow down or malfunction. If this occurs, set your computer
display's Hardware acceleration setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel] and
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98, click the [Start]
menu and select [Settings], followed by [Control Panel].

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced]
button and [Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings]
tab, [Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98, click the [Display] icon, followed by
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].

4. Restart the computer if prompted.
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If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with
Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 4 the titles and comments
you input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in
which you installed ZoomBrowser EX 4. (e.g. C:\Program
Files\Canon\ZoomBrowser EX\Program)

. Double-click [dbconverter.exe] found in this folder to start this utility.

. Select the database file you were using up to this point and click the
[Start] button.

(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My
Database.zbd)

w N

This will display the titles and comments input in the earlier versions in
the comments section of ZoomBrowser EX 4.

If You Had Images in a Folder Below the Program Files Folder

Image files in the [Program Files] folder or a subfolder cannot be displayed
in ZoomBrowser EX 4 from that location. To display these files, first
perform steps 1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains
from the [Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser
EX\Library One to another location.

The moved folder images can now be selected and displayed with
ZoomBrowser EX'4.
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